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Safety Information
When using this machine, the following safety precautions should always be followed.

Safety During Operation
In this manual, the following important symbols are used: 

 WARNING: 

 WARNING:
Indicates a potentially hazardous situation which, if instructions are not 
followed, could result in death or serious injury.

 CAUTION:
Indicates a potentially hazardous situation which, if instructions are not 
followed, may result in minor or moderate injury or damage to property.

• Disconnect the power plug (by pulling the plug, not the cable) if the power 
cable or plug becomes frayed or otherwise damaged.

• To avoid hazardous electric shock or laser radiation exposure, do not 
remove any covers or screws other than those specified in this manual.

• Turn off the power and disconnect the power plug (by pulling the plug, not 
the cable) if any of the following occurs:

• You spill something into the machine.
• You suspect that your machine needs service or repair.
• The external housing of your machine has been damaged.

• Do not incinerate used toner or toner containers. Toner dust might ignite 
when exposed to an open flame.

• Do not store toner, used toner, or toner containers in a place with an open 
flame. The toner might ignite and cause burns of a fire.

• Disposal can take place at our authorized dealer.

• Dispose of used toner containers in accordance with local regulations.

• Keep the machine away from flammable liquids, gases, and aerosols. 
A fire or an electric shock might occur.

• Connect the machine to the power source specified on the inside front 
cover of this manual and do not use any other power sources. Connect the 
power cord directly to a wall outlet and do not use an extension cord. Power 
sources not specified on the inside front cover of this manual and 
extension cords are electric shock or fire hazards.

• Do not make modifications or replacements other than those mentioned in 
this manual.

• Power cords that are damaged, broken, modified, trapped under heavy 
objects, pulled hard, or bent severely are electric shock and fire hazards.

• If the power cord is damaged (exposure of the core, disconnection, etc.), 
contact your service representative to change a new one. Operating the 
machine with a damaged power cord may cause an electric shock or fire.

 CAUTION: 

• Protect the machine from dampness or wet weather, such as rain and snow.
• Unplug the power cord from the wall outlet before you move the machine. While 

moving the machine, you should take care that the power cord will not be 
damaged under the machine.

• When you disconnect the power plug from the wall outlet, always pull the plug 
(not the cable).

• To disconnect the power cord, pull it out by plug. Do not drag the cord itself. Doing 
so may result in damage to the cord, leading to fire or electric shock.

• For safety reason, unplug the power cord from the wall outlet if the machine will 
not be used for an extended period of time such as holidays.

• Do not allow paper clips, staples, or other small metallic objects to fall inside the 
machine.

• Keep toner (used or unused) and toner cartridge out of reach of children.
• Be careful not to cut yourself on any sharp edges when you reach inside the 

machine to remove misfed sheets of paper or masters.
• For environmental reasons, do not dispose of the machine or expended supply 

waste at household waste collection points. Disposal can take place at an 
authorized dealer.

• The inside of the machine could be very hot. Do not touch the parts with a label 
indicating the “hot surface”. Otherwise, an injury might occur.

• The fusing section of this machine might be very hot. Caution should be taken 
when removing misfed paper.

• Keep the machine away from humidity and dust. Otherwise a fire or an electric 
shock might occur.

• Do not place the machine on an unstable or tilted surface. If it topples over, an 
injury might occur.

• Do not use aluminum foil, carbon paper, or similar conductive paper to avoid a fire 
or a machine failure.

• Make sure the room where you are using the machine is well ventilated and 
spacious. Good ventilation is especially important when the machine is used 
heavily.

• Do not open toner containers forcefully. Toner can spill, dirtying your clothes or 
hands, and possibly resulting in accidental ingestion.

• If toner or used toner is inhaled, gargle with plenty of water and move into a fresh 
air environment. Consult a doctor if necessary.

• If toner or used toner gets into your eyes, flush thoroughly with eyewash or water. 
Consult a doctor if necessary.

• If toner or used toner is swallowed, dilute by drinking a large amount of water. 
Consult a doctor if necessary.

• Avoid getting toner on your clothes or skin when removing a paper jam or 
replacing toner. If your skin comes into contact with toner, wash the affected area 
thoroughly with soap and water.

• If toner gets on your clothing, wash with cold water. Hot water will set the toner 
into the fabric and may make removing the stain impossible.

• Do not look into the lamp - it can damage your eyes.
• When loading paper, take care not to trap or injure your fingers.

Download from Www.Somanuals.com. All Manuals Search And Download.



ii

 CAUTION: 

Notes for Users

If you continuously print multiple pages, moist or vapor may appear from the paper exit 
area. However this will not have any impact on the performance of your printer. Be 
cautious not to touch the surface, or wait until cooled down, and keep children away 
from the surface.

Power Supply
The socket-outlet shall be in stalled near the product and shall be easily accessible.

Positions of Labels and Hallmarks for WARNING and 
CAUTION Labels

This machine has labels for WARNING and CAUTION at the positions shown 
below. For safety, please follow the instructions and handle the machine as indicated.

*This label is stuck to hot surfaces. Be careful not to touch these areas.

In accordance with IEC 60417, this machine uses the following symbols for the main 
power switch: 

 means POWER ON.
 means POWER OFF.

• During operation, rollers for transporting the paper revolve. A safety device is 
being installed so that the machine can be operated safely. But take care not to 
touch the rollers during operation. An injury might occur.

• Fire and breakdown can result from heavy accumulation of dust inside this 
machine. Consult your service representative for details about and charges for 
cleaning the machine’s interior.

• If you have to move the machine when the optional paper tray unit is attached, do 
not push on the main unit's top section. Doing so can cause the optional paper 
tray unit to detach, possibly resulting in injury.

• Before moving the machine, be sure to pull all four handles fully out. If not, an 
injury might occur. After moving the machine, return the four handles to their 
original positions.

• After you move the machine, use the caster fixture to fix it in place. Otherwise the 
machine might move or come down to cause an injury.

Power Saver
This printer contains advanced energy conservation technology that reduces power 
consumption when it is not in active use.
When the printer does not receive data for an extended period of time, power 
consumption is automatically lowered. 

ENERGY STAR® Program 

The ENERGY STAR® Program encourages energy conservation by promoting energy 
efficient computers and other office equipment.
The program backs the development and dissemination of products that feature energy 
saving functions.
It is an open program in which manufacturers participate voluntarily.
Targeted products are computers, monitors, printers, facsimiles, copiers, scanners, and 
multifunction devices. Energy Star standards and logos are internationally uniform.

Recycling
Please recycle or dispose of packaging materials for this product in 
an environmentally responsible manner.

User Information on Electrical & Electronic Equipment

Users in the EU, Switzerland and Norway

Our Products contain high quality components and are designed to facilitate recycling.
Our products or product packaging are marked with the symbol below.

The symbol indicates that the product must not be treated as municipal 
waste. It must be disposed of separately via the appropriate return and 
collection systems available. By following these instructions you ensure 
that this product is treated correctly and help to reduce potential impacts 
on the environment and human health, which could otherwise result from 
inappropriate handling. Recycling of products helps to conserve natural 
resources and protect the environment. For more detailed information on 
collection and recycling systems for this product, please contact the shop 
where you purchased it, your local dealer or sales/service representatives.

All Other Users

If you wish to discard this product, please contact your local authorities, the shop where 
you bought this product, your local dealer or sales/service representatives.
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Laser Safety:

Caution:
Use of controls or adjustment or performance of procedures other than those specified 
in this manual might result in hazardous radiation exposure.

For Users in Europe

This machine is considered class 1 laser device, safe for office/ EDP use. The machine 
contains 1 AlGaAs laser diode, 10 milliwatt, 770 - 795 nanometer wavelength for each 
emitter.
Direct (or indirect reflected) eye contact with the laser beam might cause serious eye 
damage. Safety precautions and interlock mechanisms have been designed to prevent 
any possible laser beam exposure to the operator. 
The following label is attached on rear side of the printer. 

For Users in the United States of America

CDRH Regulations
This equipment complies with requirements of 21 CRF subchapter J for class 1 laser 
products. This equipment contains 1 AlGaAs laser diode, 10 milliwatt, 770 - 795 
nanometer wavelength for each emitter. This equipment does not emit hazardous light, 
since the beam is totally enclosed during all customer modes of operation and 
maintenance.

Note to users in the United States of America

Note:
This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses and can radiate radio frequency energy and, if not installed 
and used in accordance with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that interference will not occur in a 
particular installation. If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off and on, the 
user is encouraged to try to correct the interference by one more of the following 
measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the 

receiver is connected.
• Consult the dealer or an experienced radio /TV technician for help.

Caution
Changes or modifications not expressly approved by the party responsible for 
compliance could void the user's authority to operate the equipment.

Declaration of Conformity

This device complies with Part 15 of the FCC Rules.
Operation is subject to the following two conditions:

1. This device may not cause harmful interference, and

2. this device must accept any interference received,
including interference that may cause undesired operation.
Responsible party: Ricoh Americas Corporation
Address: 5 Dedrick Place, West Caldwell, NJ 07006
Telephone number: 973-882-2000
Product Name: Laser Printer
Model Number: SP 3300DN/SP 3300D

Notes for Users

LAMP(S) INSIDE THIS PRODUCT CONTAIN MERCURY AND MUST BE RECYCLED 
OR DISPOSED OF ACCORDING TO LOCAL, STATE OR FEDERAL LAWS.

Note to users in Canada

Note:
This Class B digital apparatus complies with Canadian ICES- 003.

Remarque concernant les utilisateurs au Canada

Avertissement
Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
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1.1   <Introduction>

1 Introduction
Congratulations on the purchase of your printer!

This chapter includes:
• Special features
• Printer overview
• Control panel overview
• Understanding the LEDs
• Finding more information
• Setting up the hardware
• Altitude adjustment
• Changing the font setting

Special features
Your new printer is equipped with several special features that improve 
the print quality. You can:

Print with excellent quality and high speed
• You can print up to 1200 x 1200 dpi effective 

output. See the Software Section.
• Your printer prints A4-sized paper at up to 28 ppma 

and letter-sized paper at up to 30 ppm. For duplex 
printing, your printer prints A4-sized paper at up to 
14 ipmb and letter-sized paper at up to 14.5 ipm.

Handle paper flexibly
• Manual tray supports one sheet of envelopes, 

labels, transparencies, custom-sized materials, 
postcards and heavy paper.

• Standard 250-sheet tray supports plain paper.
• 150-sheet output tray supports convenient access.

Create professional documents
• Print Watermarks. You can customize your 

documents with words, such as “Confidential”. See 
the Software Section.

• Print Booklets. This feature enables you to easily 
print a document to create a book. Once printed, all 
you have to do is fold and staple the pages. See 
the Software Section.

• Print Posters. The text and pictures of each page 
of your document are magnified and printed across 
the sheet of paper and can then be taped together 
to form a poster. See the Software Section.

Save time and money

• Your printer allows you to use toner save mode to 
save toner. See the Software Section.

• You can print on both sides of the paper to save 
paper. See the Software Section.

• You can print multiple pages on a single sheet of 
paper to save paper. See the Software Section.

• You can use preprinted forms and letterhead with 
plain paper. See the Software Section.

• Your printer automatically conserves electricity 
by substantially reducing power consumption when 
not in use.

Expand the printer capacity
• Your printer has 32 MB of memory which can be 

expanded to 160 MB. See page 10.1. 
• You can add a 250-sheet optional tray 2 to your 

printer. This tray lets you add paper to the printer 
less often.

* Zoran IPS Emulation compatible with PostScript 3
• © Copyright 1995-2005, Zoran Corporation. 
All rights reserved. Zoran, the Zoran logo,       
IPS/PS3 and OneImage are trademarks of 
Zoran Corporation.

* 136 PS3 fonts
• Contains UFST and MicroType from Monotype Imaging Inc.

Print in various environments
•  You can print in Windows 2000/XP/Vista and 

Windows Server 2003.
•  Your printer is compatible with Macintosh.
•  Your printer comes with USB interfaces. 

a. pages per minute
b. images per minute

1 2

3 4
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Machine features

The table below shows a general overview of features supported by your 
printer.
(I: Installed, NA: Not Available)

Features SP 3300D SP 3300DN

USB 2.0
(USB 2.0: Hi-Speed USB 2.0)

I I

Network Interface
(Ethernet 10/100 Base TX)

NA I

PCL Emulation I I

PostScript Emulation I I

Duplex printinga

a. Printing on both sides of paper.

I I

Printer overview

Front view

1 output tray 6 tray 1
2 control panel 7 optional tray 2 
3 control board cover 8 paper level indicator
4 front cover 9 output support
5 manual tray 10 manual tray paper width 

guides

* SP 3300DN is shown in the above figure. 
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Rear view

Control panel overview

1 network porta

a. SP 3300DN only.

4 duplex unit
2 USB port 5 power receptacle
3 optional tray 2 cable 

connector
6 power switch

1 Alert: Indicates the status of your printer. See page 9.5.

2 Online: Indicates the status of your printer. See page 9.5.

3 Cancel: Prints a demo page or configuration page. 
Cancels the print job. 
Makes the printer pick up the print media.

* SP 3300DN is shown in the above figure. 

Understanding the LEDs

LED Status Description

Alert Red On • The cover is open. Close the 
cover.

• There is no paper in the tray. 
Load paper in the tray.

• The printer has stopped printing 
due to a major error.

• The toner cartridge is not 
installed. Install the toner 
cartridge.

• Your system has some 
problems. If this problem occurs, 
contact your service 
representative. 

• The toner cartridge is totally 
exhausted. Remove the old 
toner cartridge and install a new 
one. See page 8.4.

Blinking • A minor error is occurring and 
the printer is waiting for the error 
to be cleared. When the problem 
is cleared, the printer resumes 
printing. 

• The toner cartridge is low or 
empty. Order a new toner 
cartridge. You can temporarily 
improve print quality by 
redistributing the toner. See 
page 8.3. To check the 
remaining toner, see "Web 
Image Monitor" or print 
"Configuration page". See page 
2.2 in the Network Printer User's 
Guide or page 8.5 in the User's 
Guide, respectively.

Orange On • A paper jam has occurred. To 
solve the problem, see page 9.1.

Online Green On • The printer is in power save 
mode.

• The printer is on-line and can 
receive data from the computer.

Blinking • Blinks slowly indicates that the 
printer is receiving data from the 
computer.

• Blinks quickly indicates that the 
printer is printing data.
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Finding more information
You can find information for setting up and using your printer from the 
following resources, either printed or onscreen.

Quick Install 
Guide

Provides information on setting up your 
printer, therefore, be sure to follow the 
instructions in the guide to get the printer 
ready.

Online User’s 
Guide

Provides you with step-by-step instructions for 
using your printer’s full features, and contains 
information for maintaining your printer, 
troubleshooting, and installing accessories.
This user’s guide also contains a Software 
Section providing you with information on how 
to print documents with your printer on various 
operating systems, and how to use the 
supplied software utilities.

Printer Driver 
Help

Provides you with help information on printer 
driver properties and instructions for setting up 
the properties for printing. To access a printer 
driver help screen, click Help from the printer 
properties dialog box.

Note
You can access the user’s guides in other 
languages from the Manual folder on the 
supplied CD-ROM.

Setting up the hardware
This section shows the steps to set up the hardware which is explained 
in the Quick Install Guide. Make sure you read Quick Install Guide and 
complete following steps.

1 Select a stable location. 

Select a level, stable place with adequate space for air circulation. 
Allow extra space to open covers and trays. 

The area should be well-ventilated and away from direct sunlight or 
sources of heat, cold, and humidity. Do not set the machine close to 
the edge of your desk or table. 

Printing is suitable for altitudes under 1,000 m (3,281 ft). Refer to 
the altitude setting to optimize your printing. See page 1.5 for more 
information.
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Place the machine on a flat and stable surface for not letting it tilt 
more than 2 mm (0.08 inches). Otherwise, it may affect the printing 
quality. 

2 Unpack the machine and check all the enclosed items.

3 Remove the tape holding the machine tightly.

4 Install the toner cartridge.

5 Load paper. (See "Loading paper" on page 5.4.)

6 Make sure that all the cables are connected to the machine. 

7 Turn the machine on. 

Notes
• When you move the machine, do not tilt or turn it upside down. 

Otherwise, the inside of the machine may be contaminated by 
toner, which can cause damage to the machine or bad printing 
quality.

• When the printer driver is in the installation process, the driver 
detects the locale information of your operating system, and 
sets the paper size for your machine. If you use the different 
Windows locale, you must change the paper size of your 
machine for matching your commonly used paper size. Open 
the printer properties to change the paper size.

Altitude adjustment
The print quality is affected by atmospheric pressure, which is 
determined by the height of the machine above sea level. The following 
information will guide you on how to set your machine to the best print 
quality.

Before you set the altitude value, find the altitude where you are using 
the machine. 

1 Ensure that you have installed the printer driver with the provided     
supplied CD-ROM.

2 For Windows, from the Start menu, select Programs or All 
Programs > SP 3300 Series > Printer Settings Utility.

For MAC OS X, open the Applications folder > RNP > SP 3300 
Series > Printer Settings Utility.

3 Click Setting > Altitude Adjustment. Select the appropriate value 
from the dropdown list, and then click Apply. 

Note
If your machine is connected to a network, Web Image Monitor SP 3300 
Series screen appears automatically. Click Machine Settings > Setup 
(or Machine Setup) > Altitude Adj. Select the appropriate altitude 
value, and then click Apply.

High 31

Normal4

Value

2 High 2

3 High 1
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Changing the font setting
Your machine has preset the font for your region or country. 

If you want to change the font or set the font for special conditions such 
as DOS environment, you can change the font setting as follows: 

1 Ensure that you have installed the printer driver from the provided 
supplied CD-ROM.

2 For Windows, from the Start menu, select Programs or All 
Programs > SP 3300 Series > Printer Settings Utility.

For MAC OS X, open the Applications folder > RNP > SP 3300 
Series > Printer Settings Utility.

3 Click Emulation.

4 Confirm if PCL is selected in Emulation Setting.

5 Click Setting.

6 Select your preferred font in the Symbol set list.

7 Click Apply.

Note
Following information shows the proper font list for corresponding 
languages.
• Russian: CP866, ISO 8859/5 Latin Cyrillic
• Hebrew: Hebrew 15Q, Hebrew-8, Hebrew-7 (Israel only)
• Greek: ISO 8859/7 Latin Greek, PC-8 Latin/Greek
• Arabic & Farsi: HP Arabic-8, Windows Arabic, Code Page 864, 

Farsi, ISO 8859/6 Latin Arabic
• OCR: OCR-A, OCR-B
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2 Basic setup
This chapter includes:
• Printing a demo page
• Using toner save mode

Printing a demo page
After setting up your printer, print a demo page to make sure that the 
printer is operating correctly.

Press and hold the Cancel button for about 2 seconds.

A demo page prints out.

Using toner save mode
Toner save mode allows the printer to use less toner on each page. 
Activating this mode extends the life of your toner cartridge and reduces 
your cost per page beyond what one would experience in the normal 
mode, but it reduces print quality.

You can set the toner save mode from the printer properties window on 
your printer driver. See the Software Section.
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3 Software overview
This chapter gives you an overview of the software that comes with your 
printer. Further details about installing and using the software are 
explained in the Software Section.

This chapter includes:
• Supplied software
• Printer driver features
• System requirements

Supplied software
You must install the printer software using the supplied CD-ROM after 
you have set up your printer and connected it to your computer. 

The CD provides you with the following software:

Contents

Windows • Printer driver: Use this driver to take full advantage 
of your printer’s features.

• Status Monitor: This program allows you to monitor 
the printer’s status and alerts you when an error 
occurs during printing.

• Printer Settings Utility: This program is 
automatically installed when you install the Status 
Monitor. 

• PCL6 driver: Use this driver to print documents in 
the PCL6, PCL5e language.

• PostScript Printer Description (PPD) file: Use the 
PostScript driver to print documents with complex 
fonts and graphics in the PostScript language.

• Set IP: Use this program to set your printer’s TCP/
IP addresses. 

• User’s Guide in PDF

Macintosh • Printer driver: Use this driver to run your printer 
from a Macintosh computer and print documents.

• Printer Settings Utility: This program allows you to 
configure various printer settings. 

• Set IP: Use this program to set your printer’s TCP/
IP addresses. 

Printer driver features
Your printer drivers support the following standard features:
• Paper source selection
• Paper size, orientation and type
• Number of copies

In addition, you can use various special printing features. The following 
table shows a general overview of features supported by your printer 
drivers: 

Feature
PCL 6 PostScript

Windows Windows Macintosh

Toner save O O O

Print quality option O O O

Poster printing O X X

Multiple pages per 
sheet (N-up)

O O O

Fit to page printing O O O

Scale printing O O O

Watermark O X X

Overlay O X X
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System requirements
Before you begin, ensure that your system meets the following 
requirements:

Windows

Item Requirements Recommended

Operating 
system

Windows 2000/XP/Vista and Windows Server 2003

CPU Windows 2000 Pentium II 
400 MHz or 
higher

Pentium III 
933 MHz

Windows XP/
Vista and 
Windows Server 
2003

Pentium III 
933 MHz or 
higher

Pentium IV 
1 GHz

RAM Windows 2000 64 MB or more 128 MB

Windows XP 
and Windows 
Server 2003

128 MB or more
256 MB

Windows Vista 512 MB or more 1 GB

Free disk 
space

Windows 2000 600 MB or more 1 GB

Windows XP 
and Windows 
Server 2003

1 GB or more 5 GB

Windows Vista 15 GB 15 GB or more

Internet 
Explorer

Windows 2000/
XP and 
Windows Server 
2003

5.0 or higher

Windows Vista 7.0 or higher

Note
• For Windows 2000/XP/Vista and Windows Server 2003, users 

who have an administrator right can install the software. 

Macintosh

Operating 
system

Requirement (Recommended)

CUP RAM Free HDD 
space

Mac OS X 10.4 
or lower

• PowerPC 
G4/G5

• Intel 
processors

• 128 MB for a 
PowerPC based 
MAC (512 MB)

• 512 MB for an 
Intel based 
MAC (1 GB)

1 GB

Mac OS X 10.5 • 867 MHz or 
faster 
PowerPC 
G4/G5

• Intel 
processors

512 MB (1 GB) 1 GB
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4 Network setup (SP 3300DN 
only)
This chapter gives you basic information for setting up your printer for 
network connections.

This chapter includes:
• Introduction
• Supported operating systems
• Using SetIP program

Introduction
Once you have connected your printer to a network with an RJ-45 
Ethernet cable, you can share the printer with other network users.

You need to set up the network protocols on the printer to use it as your 
network printer. Protocols can be set up by the following programs:
• Web Image Monitor SP 3300 Series: A web server embedded to 

your network print server, which allows you to configure the network 
parameters necessary for the printer to connect to various network 
environments.

• SetIP: A utility program allowing you to select a network interface and 
manually configure the addresses for use with the TCP/IP protocol. 
This program is on the supplied CD-ROM that comes with your 
printer.

Supported operating systems
The following table shows the network environments supported by the 
printer: 

• TCP/IP: Transmission Control Protocol/Internet Protocol
• DHCP: Dynamic Host Configuration Protocol
• BOOTP: Bootstrap Protocol

Item Requirements

Network interface • 10/100 Base-TX

Network operating 
system

• Windows 2000/XP (32/64 bit)/Vista and 
Windows Server 2003

• Mac OS 8.6~9.2, 10.1~10.5

Network protocols • TCP/IP
• EtherTalk
• HTTP 1.1
• SNMP
• Bonjour

Dynamic 
addressing server

• DHCP, BOOTP

Using SetIP program 
This program is for the network IP setting using the MAC address which 
is the hardware serial number of the network printer card or interface. 
Especially, it is for the network administrator to set several network IPs 
at the same time. 

1 Insert the supplied CD-ROM provided along with your machine. 

2 Start Windows Explorer and open the X drive. (X represents your 
CD-ROM drive.)

3 Double click Application > SetIP.

4 Open the language folder you want to use.

5 Double click Setup.exe to install this program. 

6 From the Windows Start menu, select Programs > SP 3300 Series 
> Set IP.

7 Select the name of your printer and click “  ”. 

8 Enter the network card’s MAC address, IP address, subnet mask, 
default gateway, and then click Apply.

9 Click OK to confirm the settings.

10 Click Exit to close the SetIP program.

Note
If you want to setup DHCP network protocol, go to the http://
developer.apple.com/networking/bonjour/download/, select 
the program Bonjour for Windows due to your computer 
operating system, and install the program. This program will 
allow you to fix the network parameter automatically. Follow 
the instruction in the installation window. 

Note
If you cannot find your printer name click “  ” to refresh the 
list.

Note
If you do not know the network card’s MAC address, print the 
machine’s network information report. 
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5 Loading print media
This chapter will help you understand the types of paper you can use 
with your printer and how to properly load paper in the different paper 
trays for the best print quality. 

This chapter includes:
• Selecting print media
• Loading paper
• Knowing an output location

Selecting print media
You can print on a variety of print media, such as plain paper, envelopes, 
labels, and transparencies. Always use print media that meet the 
guidelines for use with your printer. Print media that does not meet the 
guidelines outlined in this user’s guide may cause the following 
problems:
• Poor print quality
• Increased paper jams
• Premature wear on the machine.

Properties, such as weight, composition, grain, and moisture content, 
are important factors that affect the machine’s performance and the 
output quality. When you choose print materials, consider the following:
• The type, size and weight of the print media for your machine are 

described later in this section.
• Desired outcome: The print media you choose should be appropriate 

for your project.
• Brightness: Some print media are whiter than others and produce 

sharper, more vibrant images.
• Surface smoothness: The smoothness of the print media affects how 

crisp the printing looks on the paper. 

Notes
• Using print media that does not meet these specifications may 

cause problems, requiring repairs. Such repairs are not 
covered by the warranty or service agreements.

• Some print media may meet all of the guidelines in this section 
and still not produce satisfactory results. This may be the 
result of improper handling, unacceptable temperature and 
humidity levels, or other variables over which manufacturer 
has no control.

• Before purchasing large quantities of print media, ensure that 
it meets the requirements specified in this user’s guide. 
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Supported sizes of paper

Print media for duplex printing

Type Size Dimensions Weighta

a. If media weight is over 24 lb (90 g/m2), use the manual feed.

Capacityb

b. Maximum capacity may differ depending on media weight, thickness, and environmental conditions.

Plain paper

Letter 216 x 279 mm (8.5 x 11 inches) • 60 to 105 g/m2 (16 to 24 lb 
bond) for the tray

• 60 to 163 g/m2 (16 to 43 lb 
bond) for the manual feed

• 250 sheets of 75 g/m2 
(20 lb bond) paper for the 
tray

• 1 sheet in the manual tray

Legal 216 x 356 mm (8.5 x 14 inches)

Folio 216 x 330.2 mm (8.5 x 13 inches)

Oficio 216 x 343 mm (8.5 x 13.5 inches)

A4 210 x 297 mm (8.26 x 11.69 inches)

JIS B5 182 x 257 mm (7.18 x 10.12 inches)

ISO B5 176 x 250 mm (6.93 x 9.84 inches)

Executive 184 x 267 mm (7.25 x 10.5 inches)

A5 148 x 210 mm (5.82 x 8.26 inches)

A6 105 x 148 mm (4.13 x 5.82 inches)

Envelope

Envelope B5 176 x 250 mm (6.93 x 9.84 inches)

75 to 90 g/m2 (20 to 24 lb)

1 sheet in the manual tray

Envelope Monarch 98.4 x 190.5 mm (3.88 x 7.5 inches)

Envelope COM-10 105 x 241 mm (4.12 x 9.5 inches)

Envelope DL 110 x 220 mm (4.33 x 8.66 inches)

Envelope C5 162 x 229 mm (6.38 x 9.02 inches)

Envelope C6 114 x 162 mm (4.49 x 6.38 inches)

Transparency Letter, A4 Refer to the Plain paper section 138 to 146 g/m2 (37 to 39 lb) 1 sheet in the manual tray

Labels

Letter, Legal, Folio, 
Oficio, A4, JIS B5, 
ISO B5, Executive, 
A5, A6

Refer to the Plain paper section 120 to 150 g/m2 (32 to 40 lb)
1 sheet in the manual tray

Card stock

Letter, Legal, Folio, 
Oficio, A4, JIS B5, 
ISO B5, Executive, 
A5, A6

Refer to the Plain paper section 60 to 163 g/m2 (16 to 43 lb)
1 sheet in the manual tray

Minimum size (custom) 76 x 127 mm (3.86 x 5.83 inches) 60 to 163 g/m2

(16 to 43 lb bond)
1 sheet in the manual tray

Maximum size (custom) 215.9 x 356 mm (8.5 x 14 inches)

Type Size Weight

Plain paper, 
Recycled paper

A4, Letter, Oficio, Legal, and Folio 75 ~ 90 g/m2 (20 to 24 lb)
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Guidelines for selecting and storing print media
When selecting or loading paper, envelopes, or other print media, keep 
these guidelines in mind:
• Always use print media that conform with the specifications listed on 

the next column.
• Attempting to print on damp, curled, wrinkled, or torn paper can cause 

paper jams and poor print quality.
• For the best print quality, use only high quality copier grade paper 

specifically recommended for use in laser printers.
• Avoid using the following print media types:

- Paper with embossed lettering, perforations, or a texture that is too 
smooth or too rough

- Erasable bond paper
- Multi-paged paper
- Synthetic paper and thermally reactive paper
- Carbonless paper and Tracing paper. 

• Use of these types of paper could result in paper jams, chemical 
smells, and damage to your printer.

• Store print media in its ream wrapper until you are ready to use it. 
Place cartons on pallets or shelves, not on the floor. Do not place 
heavy objects on top of the paper, whether it is packaged or 
unpackaged. Keep it away from moisture or other conditions that can 
cause it to wrinkle or curl.

• Store unused print media at temperatures between 15 and 30oC (59 
to 86oF). The relative humidity should be between 10 and 70%.

• Store unused print media in a moisture-proof wrap, such as a plastic 
container or bag, to prevent dust and moisture from contaminating 
your paper.

• Load special print media types one sheet at a time through the 
manual tray to avoid paper jams.

• To prevent print media, such as transparencies and label sheets, from 
sticking together, remove them as they print out.

Note
• If you print 20 envelopes in succession, the surface of the top 

cover may become hot. Please exercise caution.

Guidelines for special print media

Type Guidelines

Envelopes • Successful printing on envelopes depends 
upon the quality of the envelopes. When 
selecting envelopes, consider the following 
factors:
- Weight: The weight of the envelope paper 

should not exceed 90 g/m2 (24 lb) or jamming 
may occur.

- Construction: Prior to printing, envelopes 
should lie flat with less than 6 mm 
(0.25 inches) curl, and should not contain air.

- Condition: Envelopes should not be wrinkled, 
nicked, or otherwise damaged.

- Temperature: You should use envelopes that 
are compatible with the heat and pressure of 
the printer during operation.

• Use only well-constructed envelopes with sharp 
and well creased folds.

• Do not use stamped envelopes.
• Do not use envelopes with clasps, snaps, 

windows, coated lining, self-adhesive seals, or 
other synthetic materials.

• Do not use damaged or poorly made 
envelopes.

• Be sure the seam at both ends of the envelope 
extends all the way to the corner of the 
envelope.

• Envelopes with a peel-off adhesive strip or with 
more than one flap that folds over to seal must 
use adhesives compatible with the printer’s 
fusing temperature for 0.1 second. Check your 
machine’s specification to view the fusing 
temperature, see page 11.1. The extra flaps 
and strips might cause wrinkling, creasing, or 
jams, and may even damage the fuser.

• For the best print quality, position margins no 
closer than 15 mm (0.6 inches) from the edges 
of the envelope.

• Avoid printing over the area where the 
envelope’s seams meet.

Acceptable

Unacceptable
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Transparencies • To avoid damaging the printer, use only 
transparencies designed for use in laser 
printers.

• Transparencies used in the printer must be able 
to withstand the machine’s fusing temperature. 
Check your machine’s specification to view the 
fusing temperature, see page 11.1.

• Place them on a flat surface after removing 
them from the printer.

• Do not leave them in the paper tray for long 
periods of time. Dust and dirt may accumulate 
on them, resulting in spotty printing.

• To avoid smudging caused by fingerprints, 
handle them carefully.

• To avoid fading, do not expose printed 
transparencies to prolonged sunlight.

• Ensure that transparencies are not wrinkled, 
curled, or have any torn edges.

Labels • To avoid damaging the printer, use only labels 
designed for use in laser printers.

• When selecting labels, consider the following 
factors:
- Adhesives: The adhesive material should be 

stable at 180° C (356° F), the printer’s fusing 
temperature.

- Arrangement: Only use labels with no 
exposed backing between them. Labels can 
peel off sheets that have spaces between the 
labels, causing serious jams.

- Curl: Prior to printing, labels must lie flat with 
no more than 13 mm (5 inches) of curl in any 
direction.

- Condition: Do not use labels with wrinkles, 
bubbles, or other indications of separation.

• Make sure that there is no exposed adhesive 
material between labels. Exposed areas can 
cause labels to peel off during printing, which 
can cause paper jams. Exposed adhesive can 
also cause damage to printer components.

• Do not run a sheet of labels through the printer 
more than once. The adhesive backing is 
designed for only a single pass through the 
printer.

• Do not use labels that are separating from the 
backing sheet or are wrinkled, bubbled, or 
otherwise damaged.

Card stock or 
custom-sized 
materials

• Do not print on print media smaller than 76 mm 
(3 inches) wide or 127 mm (5 inches) long.

• In the software application, set margins at least 
6.4 mm (0.25 inches) away from the edges of 
the material.

Type Guidelines

Loading paper
Load the print media you use for the majority of your print jobs in the tray 
1. The tray 1 can hold a maximum of 250 sheets of 75 g/m2 (20 lb) plain 
paper. 

You can purchase an optional tray (tray 2) and attach it below the 
standard tray to load an additional 250 sheets of paper. 

The paper level indicator on the front of the tray 1 and the optional tray 
2 shows the amount of paper currently left in the tray. When the tray is 
empty, the indicator of the bar is completely lowered.

Preprinted 
paper

• Letterhead must be printed with heat-resistant 
ink that will not melt, vaporize, or release 
hazardous emissions when subjected to the 
printer’s fusing temperature for 0.1 second. 
Check your machine’s specification to view the 
fusing temperature, see page 11.1.

• Letterhead ink must be non-flammable and 
should not adversely affect printer rollers.

• Forms and letterhead should be sealed in a 
moisture-proof wrapping to prevent changes 
during storage.

• Before you load preprinted paper, such as 
forms and letterhead, verify that the ink on the 
paper is dry. During the fusing process, wet ink 
can come off preprinted paper, reducing print 
quality.

Type Guidelines

Full ▲ ▲ Empty
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Using the tray 1 or the optional tray 2
Use the print material you use for the majority of your print jobs in the 
tray 1. The tray 1 can hold a maximum of 250 sheets of 75 g/m2 (20 lb) 
paper.

You can purchase an optional tray 2 and attach it below the tray 1 to load 
an additional 250 sheets of paper.

To load paper, pull open the tray and load paper with the side to be 
printed on face down.

You can load letterhead paper with the design side face down. The top 
edge of the sheet with the logo should be placed at the front of the tray.

Notes
• If you experience problems with paper feed, place one sheet 

at a time in the manual feed.
• You can load previously printed paper. The printed side 

should be facing up with an uncurled edge at the front. If you 
experience problems with paper feed, turn the paper around. 
Note that the print quality is not guaranteed.

Changing the size of the paper in the tray 1
To load longer sizes of paper, such as Legal-sized paper, you need to 
adjust the paper guides to extend the paper tray.

1
2

3

4

1 paper length guide
2 support guide
3 guide lock
4 paper width guides

1 Press and hold the guide lock, and slide the paper length guide to 
locate it in the correct paper size slot.

2 After inserting paper into the tray, adjust the support guide so that it 
lightly touches the paper stack.

3 Squeeze the paper width guides, as shown and slide them to the 
stack of paper until it lightly touches the side of the stack.
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Notes
• Do not push the paper width guide far enough to cause the 

material to warp. 
• If you do not adjust the paper width guide, it may cause paper 

jams.

Using manual feeder
You can manually load a sheet of print media in the manual tray if you 
select Manual Feeder in the Source option from the Paper tab when you 
change print settings to print a document. See the Software Section. 
Manually loading paper can be helpful when you want to check the print 
quality after each page is printed. 

Load paper sheet-by-sheet in the manual tray, send print data to print the 
first page, and press the Cancel button on the control panel to print each 
following page.

1 Open the manual feed.

2 Load the paper with the side to be printed on facing up. 

3 Adjust the manual tray paper width guides to the width of the paper. 
Do not force too much, or the paper will bend, which could result in 
a paper jam or skew.

4 When you print a document, set the paper source to Manual 
Feeder and select the appropriate paper size and type in the 
software application. See the Software Section. 

5 Print a document.

6 Press the Cancel button.

The printer picks up the print media and prints.

7 Insert the next sheet into the manual tray and press the Cancel 
button. 

Repeat this step for every page to be printed.

Note
• If you do not press the Cancel button, after a pause the printer 

will automatically pick the print media.

Note
• If envelopes or thick papers(163g/m2) are printed out 

with wrinkles, crease or black bold lines, open the rear cover 
and pull the guide of both sides down. Keep the rear cover 
opened during printing.
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Knowing an output location
 

The output tray collects paper face down, in the order in which the sheets 
were printed. 

Notes
• If you continuously print many pages, the surface of the output 

tray may become hot. Be careful not to touch the surface, and 
especially keep children away from the surface.

• The output tray can hold up to 150 sheets of 75 g/m2 (20 lb) 
plain paper. Remove the pages so that the tray is not 
overloaded.

• If the printed paper is not stacked properly, turn over the stack 
of paper in the tray.

1

1 output tray
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6 Basic printing
This chapter explains common printing tasks. 

This chapter includes:
• Printing a document
• Canceling a print job

Printing a document
This printer allows you to print from various Windows and Macintosh 
applications. The exact steps for printing a document may vary 
depending on the application you use. 

For details about printing, see the Software Section.

Canceling a print job
If the print job is waiting in a print queue or print spooler, such as the 
printer group in Windows, delete the job as follows:

1 Click the Windows Start button.

2 For Windows 2000, select Settings and then Printers.

For Windows XP (32/64 bit) and Windows Server 2003, select 
Printers and Faxes.

For Windows Vista, select Control Panel > Hardware and Sound  
> Printers.

3 Double-click the SP 3300 Series icon.

4 From the Document menu, select Cancel.

You can also cancel the current job by pressing the Cancel button on the 
control panel of your printer.

Note
• You can access this window simply by double-clicking the 

printer icon at the bottom right corner of the Windows desktop.
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7 Supplies and accessories
This chapter provides information on the toner cartridge and accessory 
that are available for your printer.

This chapter includes:
• Toner cartridge
• Accessory

Toner cartridge
When the toner runs out, you can order the following type of toner 
cartridge for your printer:

Toner yield: Approx. 5,000 pages1. 

Accessory
You can purchase and install the following accessory to your printer:

1 Declared yield value in accordance with ISO/IEC 19752.

Accessory Description

Optional Tray If you are experiencing frequent paper supply 
problems, you can attach additional 250 sheet 
tray. You can print documents on various sizes 
and types of print media.

Memory DIMM The memory board is installed on the main 
controller board inside the machine. When you 
add the optional memory board, it increases 
print performance.
The machine has 32 MB of standard memory 
and a slot for optional additional memory. The 
memory can be expanded by installing an 
optional memory (128 MB).
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8 Maintenance
This chapter provides information for maintaining your printer and the 
toner cartridge.

This chapter includes:
• Cleaning the printer
• Maintaining the toner cartridge
• Printing a configuration page
• Maintenance parts

Cleaning the printer
During the printing process, paper, toner, and dust particles can 
accumulate inside the printer. This buildup can cause print quality 
problems, such as toner specks or smearing. 

Cleaning the outside of the printer
Clean the cabinet of the printer with a soft, lint-free cloth. You can 
dampen the cloth slightly with water, but be careful not to let any water 
drip onto or into the printer.

Notes
• Cleaning the cabinet of the printer with cleaning materials 

containing large amounts of alcohol, solvents, or other strong 
substances can discolor or crack the cabinet.

• If your machine or its around is contaminated with toner, we 
recommend you to use cloth or tissue dampened with water to 
clean it. If you use a vacuum cleaner, toner blows in the air and 
might be harmful for you. 

Cleaning the inside of the printer
1 Turn the printer off and unplug the power cord. Wait for the printer 

to cool down.

2 Open the front cover and pull the toner cartridge out. Set it on a 
clean flat surface.

3 With a dry lint-free cloth, wipe away any dust and spilled toner from 
the toner cartridge area and the toner cartridge cavity.

Notes
• To prevent damage to the toner cartridge, do not expose it to 

light for more than a few minutes. Cover it with a piece of 
paper, if necessary. 

• Do not touch the green surface underside of the toner 
cartridge. Use the handle on the cartridge to avoid touching 
this area.

Note
• While cleaning the inside of the printer, be careful not to reach 

too far into the printer. The fuser area may be hot.
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4 Gently swab the long strip of glass (LSU) inside the top of the 
cartridge and check for dirt or dust.

5 Hold the toner cartridge by the handle and slowly insert the 
cartridge into the opening in the printer. 

Tabs on the sides of the cartridge and corresponding grooves 
within the printer will guide the cartridge into the correct position 
until it locks into place completely.

6 Close the front cover. Make sure that the cover is securely closed.

7 Plug in the power cord and turn the printer on.

Note
• The long strip of glass is hard to locate.

Maintaining the toner cartridge  

Toner cartridge storage
To get the most from the toner cartridge, keep the following guidelines in 
mind:
• Do not remove the toner cartridge from its package until ready for 

use.
• Do not refill the toner cartridge. The printer warranty does not cover 

damage caused by using a refilled cartridge.
• Store toner cartridge in the same environment as the printer.
• To prevent damage to the toner cartridge, do not expose it to light for 

more than a few minutes.

Expected cartridge life
The life of the toner cartridge depends on the amount of toner that print 
jobs require. The actual number may also be different depending on the 
print density of the pages you print on, and the number of pages may be 
affected by operating environment, printing interval, media type, and 
media size. If you print a lot of graphics, you may need to change the 
cartridge more often.

Warning
• Do not incinerate used toner or toner containers. Toner dust 

might ignite when exposed to an open flame.
• Disposal can take place at our authorized dealer.
• Dispose of used toner containers in accordance with local 

regulations.
• Do not store toner, used toner, or toner containers in a place 

with an open flame. The toner might ignite and cause burns of 
a fire.

Caution
• Keep toner (used or unused) and toner cartridge out of reach 

of children.
• If toner or used toner is inhaled, gargle with plenty of water and 

move into a fresh air environment. Consult a doctor if 
necessary.

• If toner or used toner gets into your eyes, flush thoroughly with 
eyewash or water. Consult a doctor if necessary.

• If toner or used toner is swallowed, dilute by drinking a large 
amount of water. Consult a doctor if necessary.

• Avoid getting toner on your clothes or skin when removing a 
paper jam or replacing toner. If your skin comes into contact 
with toner, wash the affected area thoroughly with soap and 
water.

• If toner gets on your clothing, wash with cold water. Hot water 
will set the toner into the fabric and may make removing the 
stain impossible.
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Redistributing toner cartridge
When the toner cartridge is near the end of its life span:
• White streaks and light printing occur.
• The Status Monitor program window appears on the computer.
• The Alert LED blinks red.

If this happens, you can temporarily reestablish print quality by 
redistributing the remaining toner in the cartridge. In some cases, white 
streaks or light printing will still occur even after you have redistributed 
the toner.

1 Open the front cover.

2 Pull the toner cartridge out.

3 Thoroughly shake the cartridge 5 or 6 times to distribute the toner 
evenly inside the cartridge. 

Notes
• Avoid reaching too far into the printer. The fuser area may be 

hot.
• To prevent damage to the toner cartridge, do not expose it to 

light for more than a few minutes. Cover it with a piece of 
paper, if necessary. 

• Do not touch the green surface underside of the toner 
cartridge. Use the handle on the cartridge to avoid touching 
this area.

Note
• If toner gets on your clothing, wipe it off with a dry cloth and 

wash clothing in cold water. Hot water sets toner into fabric.

4 Hold the toner cartridge by the handle and slowly insert the 
cartridge into the opening in the printer. 

Tabs on the sides of the cartridge and corresponding grooves 
within the printer will guide the cartridge into the correct position 
until it locks into place completely.

5 Close the front cover. Make sure that the cover is securely closed.

Note
• At this stage, if you need to replace the toner cartridge, see 

page 8.4.
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Replacing the toner cartridge  

When the toner is completely empty or the toner cartridge reached the 
end of its life span:
• The printer stops printing.
• The Status Monitor program window appears on the computer.
• The Alert LED blinks red.

At this stage, the toner cartridge needs to be replaced. 

1 Open the front cover.

2 Pull the old toner cartridge out.

3 Remove the new toner cartridge from its bag.

Warning
• Do not incinerate used toner or toner containers. Toner dust 

might ignite when exposed to an open flame.
• Disposal can take place at our authorized dealer.
• Dispose of used toner containers in accordance with local 

regulations.

Caution
• Keep toner (used or unused) and toner cartridge out of reach 

of children.

Note
• Do not use sharp objects, such as a knife or scissors, to open 

the toner cartridge package. They might scratch the drum of 
the cartridge.

4 Thoroughly shake the cartridge 5 or 6 times to distribute the toner 
evenly inside the cartridge.

Thoroughly shake the cartridge to assure maximum copies per 
cartridge.

5 Remove the paper protecting the toner cartridge by pulling the 
packing tape.

6 Hold the toner cartridge by the handle and slowly insert the 
cartridge into the opening in the printer.

Note
• Refer to the helpful pictures on the cartridge wrapping paper.
• If toner gets on your clothing, wipe it off with a dry cloth and 

wash clothing in cold water. Hot water sets toner into fabric.
• To prevent damage to the toner cartridge, do not expose it to 

light for more than a few minutes. Cover it with a piece of 
paper, if necessary. 

• Do not touch the green surface underside of the toner 
cartridge. Use the handle on the cartridge to avoid touching 
this area.
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Tabs on the sides of the cartridge and corresponding grooves 
within the printer will guide the cartridge into the correct position 
until it locks into place completely.

7 Close the front cover. Make sure that the cover is securely closed.

Printing a configuration page
You can print a configuration page to view current printer settings, or to 
help troubleshoot printer problems.

Press and hold the Cancel button for about 5 seconds.

A configuration page prints out.

Maintenance parts
To avoid print quality and paper feed problems resulting from worn parts 
and to maintain your machine in top working condition the following 
items will need to be replaced at the specified number of pages or when 
the life span of each item has expired.

We highly recommends that an authorized service provider, dealer or the 
retailer where you bought printer performs this maintenance activity.   The 
warranty does not cover the replacement of the maintenance parts after their 
lifespan.

The warranty does not cover the replacement of the maintenance parts 
after their lifespan.

Items Yield (Average)

Transfer roller Approx. 50,000 pages

Fuser unit Approx. 50,000 pages

Pick-up roller Approx. 50,000 pages
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9 Troubleshooting
This chapter provides helpful information for what to do if you encounter 
an error while using your printer. 

This chapter includes:
• Clearing paper jams
• Troubleshooting checklist
• Solving general printing problems
• Solving print quality problems
• Common Windows problems
• Common PostScript problems
• Common Macintosh problems

Clearing paper jams

When a paper jam occurs, the Alert LED lights orange. Open and close 
the front cover. The jammed paper automatically exits the printer. 

In the paper feed area

In the tray 1

1 Pull the tray 1 open.

Note
• When removing paper that is jammed in the printer, if possible 

always pull the paper in the direction that it normally moves so 
as not to damage internal components. Always pull firmly and 
evenly; do not jerk the paper. If the paper tears, ensure that all 
fragments of paper are removed; otherwise a jam will occur 
again.

2 Remove the jammed paper by gently pulling it straight out. Make 
sure that all of the paper is properly aligned in the tray 1.

If the paper does not move when you pull, or if you do not see the 
paper in this area, check the fuser area around the toner 
cartridge. See page 9.2.

3 Insert the tray 1 into the printer until it snaps into place. Printing 
automatically resumes.

In the optional tray 2

1 Pull the optional tray 2 open.

2 Remove the jammed paper from the printer.

If the paper does not move when you pull, or if you do not see the 
paper in this area, stop and go to step 3.

3 Pull the tray 1 half.
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4 Pull the paper straight up and out.

5 Insert the trays back into the printer. Printing automatically 
resumes.

In the manual tray

1 Remove the jammed paper from the printer.

2 Open and close the front cover.

3 Load a paper into the manual feeder, then the printer resumes.

Around the toner cartridge
Note
The fuser area is hot. Take care when removing paper from the 
printer.

1 Open the front cover and pull the toner cartridge out.

2 Remove the jammed paper by gently pulling it straight out.

3 Replace the toner cartridge and close the front cover. Printing 
automatically resumes.

Notes
• To prevent damage to the toner cartridge, do not expose it to 

light for more than a few minutes. Cover it with a piece of 
paper, if necessary. 

• Do not touch the green surface underside of the toner 
cartridge. Use the handle on the cartridge to avoid touching 
this area.
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In the paper exit area

1 Open and close the front cover. The jammed paper is automatically 
ejected from the printer. 

2 Gently pull the paper out of the output tray.

If you do not see the jammed paper or if there is any resistance 
when you pull, stop and go to the next step.

3 Open the rear cover.

4 Pull the guide rear on each side down and remove the paper. 
Return the guide rear to its original position.

5 Close the rear cover. Printing automatically resumes.

Caution
• The inside of the machine could be very hot. Do not touch the 

parts with a label indicating "hot surface". Otherwise an injury 
might occur.

1 guide rear

1

In the duplex unit area
If the duplex unit is not inserted correctly, paper jam may occur. Make 
sure that the duplex unit is inserted correctly.

Duplex jam 0

1 Pull the duplex unit out of the printer.

2 Remove the jammed paper from the duplex unit.

If the paper does not come out with the duplex unit, remove the 
paper from the bottom of the printer.

1 duplex unit

1
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Duplex jam 1

1 Open the rear cover.

2 Pull the guide rear on each side down and remove the paper. 
Return the guide rear to its original position.

3 Close the rear cover. Printing automatically resumes.

Tips for avoiding paper jams
By selecting the correct media types, most paper jams can be avoided. 
When a paper jam occurs, follow the steps outlined on 9.1. 
•  Follow the procedures on 5.5. Ensure that the adjustable guides are 

positioned correctly.
•  Do not overload the tray. Ensure that the paper level is below the 

paper capacity mark on the inside wall of the tray.
•  Do not remove paper from the tray while your printer is printing.
•  Flex, fan, and straighten paper before loading. 
•  Do not use creased, damp, or highly curled paper.
•  Do not mix paper types in a tray.
•  Use only recommended print media. See 5.1.
•  Ensure that the recommended print side of print media is facing down 

in the tray, or facing up in the manual tray.
•  If paper jams occur frequently when you print on A5-sized paper:

1 guide rear

1

Load the paper into the tray with the long edge facing the front of the 
tray. 

In the printer properties window, set the page orientation to be rotated 
90 degrees. See the Software Section.
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Troubleshooting checklist
If the printer is not working properly, consult the following checklist. If the 
printer does not pass a step, follow the corresponding suggested 
solutions.

Condition Suggested solutions

Make sure that the 
Online LED on the 
control panel lights 
green.

• If the Online LED is off, check the power 
cord connection. Check the power switch. 
Check the power source by plugging the 
power cord into another outlet.

Print a demo page 
to verify that the 
printer is feeding 
paper correctly. See 
page 2.1.

• If a demo page does not print, check the 
paper supply in the tray.

• If the paper jams in the printer, see page 
9.1.

Check the demo 
page to see if it 
printed correctly.

If there is a print quality problem, see page 
9.7.

Print a short 
document from a 
software application 
to verify that the 
computer and 
printer are 
connected and are 
communicating 
correctly.

• If the page does not print, check the cable 
connection between the printer and the 
computer. 

• Check the print queue or print spooler to 
see if the printer has been paused.

• Check the software application to ensure 
that you are using the proper printer driver 
and communication port. If the page is 
interrupted during printing, see page 9.5.

If completing the 
checklist does not 
resolve the printer 
problem, check the 
following 
troubleshooting 
sections.

• “Understanding the LEDs” on page 1.3.
• “Solving general printing problems” on 

page 9.5.
• “Common Windows problems” on page 

9.9.
• “Common PostScript problems” on page 

9.10.
• “Common Macintosh problems” on page 

9.10.

Solving general printing problems
For problems with the operation of your printer, refer to the table for 
suggested solutions.

Condition Possible cause Suggested solutions

The printer 
does not 
print.

The printer is not 
receiving power.

Check the power cord 
connections. Check the power 
switch and the power source.

The printer is not 
selected as the 
default printer.

Select SP 3300 Series or SP 
3300 Series PS as your default 
printer. 

The printer cover 
is not closed.

Close the printer cover.

Paper is jammed. Clear the paper jam. See page 
9.1.

No paper is 
loaded.

Load paper. See page 5.4.

The toner 
cartridge is not 
installed.

Install the toner cartridge.

The printer may 
be in manual feed 
mode and out of 
paper.

Add paper to the manual tray, 
and press the Cancel button 
on the control panel.

The connection 
cable between 
the computer and 
the printer is not 
connected 
properly.

Disconnect the printer cable 
and reconnect it.

The connection 
cable between 
the computer and 
the printer is 
defective.

If possible, attach the cable to 
another computer that is 
working properly and try to print 
a document. You can also try 
using a different printer cable.

The port setting is 
incorrect.

Check the Windows printer 
setting to make sure that the 
print job is sent to the correct 
port. If the computer has more 
than one port, make sure that 
the printer is attached to the 
correct one.
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The printer 
does not 
print.
(Continued)

The printer may 
be configured 
incorrectly. 

Check the printer properties to 
ensure that all of the print 
settings are correct. 

The printer driver 
may be 
incorrectly 
installed.

Reinstall the printer driver; See 
the Software Section. Try 
printing a test page.

The printer is 
malfunctioning.

Check the LEDs on the control 
panel to determine if the printer 
is indicating a system error.

Printer 
selects print 
media from 
the wrong 
paper 
source.

The paper source 
selection in the 
printer properties 
may be incorrect.

For many software 
applications, the paper source 
selection is found under the 
Paper tab within the printer 
properties. Select the correct 
paper source. See the 
Software Section.

Paper does 
not feed into 
the printer.

Paper has not 
been loaded 
correctly.

Remove paper from the tray 
and reload it correctly.
Check that the adjustable 
guides are set correctly.

There is too much 
paper in the tray.

Remove excess paper from the 
tray.

The paper is too 
thick.

Use only paper that meets 
printer specifications.

Print job is 
extremely 
slow.

The job may be 
very complex.

Reduce the complexity of the 
page(s) or try adjusting the 
print quality settings.
To adjust the print quality 
settings, reduce the resolution. 
If you have set the resolution to 
1200 dpi (Best), change it to 
600 dpi (Normal). See the 
Software Section.
Change the port setting to the 
USB or network port to improve 
print speed.
Your printer prints A4-sized 
paper at 28 ppm and letter-
sized paper at 30 ppm.

The computer 
may have 
insufficient 
random-access 
memory (RAM). 

Simplify the page layout and 
remove any unnecessary 
graphics from the document.

Condition Possible cause Suggested solutions

Half the page 
is blank.

The page layout 
is too complex.

Simplify the page layout and 
remove any unnecessary 
graphics from the document.

The page 
orientation setting 
may be incorrect.

Change the page orientation in 
your application. See the 
Software Section.

The paper size 
and the paper 
size settings do 
not match.

Ensure that the paper size in 
the printer driver settings 
matches the paper in the tray.
Or, ensure that the paper size 
in the printer driver settings 
matches the paper selection in 
the software application 
settings you use.

The paper 
keeps 
jamming.

There is too much 
paper in the tray.

Remove excess paper from the 
tray. 
If printing on special print 
media, use the manual tray.

An incorrect type 
of paper is being 
used.

Use only paper that meets 
printer specifications.
If printing on special print 
media, use the manual tray.

There may be 
debris inside the 
printer.

Open the front cover and 
remove the debris.

The printer 
prints, but 
the text is 
wrong, 
garbled, or 
incomplete.

The printer cable 
is loose or 
defective.

Disconnect and reconnect the 
printer cable. Try a print job that 
you have already printed 
successfully. If possible, attach 
the cable and printer to another 
computer and try a print job 
that you know works. Finally, 
try a new printer cable.

The wrong printer 
driver was 
selected.

Check the application’s printer 
selection menu to ensure that 
your printer is selected.

The software 
application is 
malfunctioning.

Try printing a job from another 
application.

If you are under 
the DOS 
environment, the 
font setting for 
your machine 
may be set 
incorrectly.

Change the font setting. See 
page 1.6.

Condition Possible cause Suggested solutions
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Pages print, 
but are 
blank.

The toner 
cartridge is 
defective or out of 
toner.

Redistribute the toner 
cartridge. See page 8.3.
If necessary, replace the toner 
cartridge. See page 8.4.

The file may have 
blank pages.

Check the file to ensure that it 
does not contain blank pages.

Some parts, such 
as the controller 
or the board, may 
be defective.

Contact a service 
representative.

The 
illustrations 
print 
incorrectly in 
Adobe 
Illustrator.

The setting in the 
software 
application is 
wrong.

Select Download as Bitmap in 
the Advanced Options window 
of the graphic properties. Print 
the document again.

The printer 
does not 
print PDF file 
correctly. 
Some parts 
of graphics, 
text, or 
illustrations 
are missing.

Incompatibility 
between the PDF 
file and the 
Acrobat products.

Printing the PDF file as an 
image may solve this problem. 
Turn on Print As Image from 
the Acrobat printing options.
Note: It will take longer to print 
when you print a PDF file as an 
image.

Condition Possible cause Suggested solutions Solving print quality problems
Dirt inside of the printer or improper paper loading may reduce print 
quality. See the table below to troubleshoot problems. 

Condition Suggested solutions

Light or faded 
print

If a vertical white streak or faded area appears 
on the page:
• The toner supply is low. You may be able to 

temporarily extend the toner cartridge life. See 
page 8.3. If this does not improve print quality, 
install a new toner cartridge.

• The paper may not meet paper specifications 
(for example, the paper is too moist or too 
rough). See page 5.3.

• If the entire page is light, the print resolution 
setting is too light or toner save mode is on. 
Adjust the print resolution and toner save 
mode in the printer properties. See the 
Software Section.

• A combination of faded or smeared defects 
may indicate that the printer needs cleaning. 
See page 8.1.

• The surface of LSU may be dirty. Clean the 
LSU. See page 8.2.

Toner spots • The paper may not meet specifications (for 
example, the paper is too moist or too rough). 
See page 5.3.

• The transfer roller or paper path may be dirty. 
See page 8.1.

Dropouts If generally rounded, faded areas occur 
randomly on the page:
• A single sheet of paper may be defective. Try 

reprinting the job.
• The moisture content of the paper is uneven 

or the paper has moist spots on its surface. 
Try a different brand of paper. See page 5.3.

• The paper lot is bad. The manufacturing 
processes can cause some areas to reject 
toner. Try a different kind or brand of paper.

• The toner cartridge may be defective. See 
“Vertical repetitive defects” on the next 
column.

• If these steps do not correct the problems, 
contact a service representative.
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Vertical lines If black vertical streaks appear on the page:
• The drum inside the toner cartridge has 

probably been scratched. Install a new toner 
cartridge. See page 8.4.

If white vertical streaks appear on the page:
• The surface of the LSU part inside the printer 

may be dirty. Clean the LSU. See page 8.2.

Gray 
background

If the amount of background shading becomes 
unacceptable, the procedures below may fix the 
problem.
• Change to lighter weight pages. See page 5.3.
• Check the printer’s environment; low humidity 

(lower than 20% RH) or high humidity (higher 
than 80% RH) conditions can increase the 
amount of background shading.

• Remove the old toner cartridge and install a 
new one. See page 8.4.

Toner smear • Clean the inside of the printer. See page 8.1.
• Check the paper type and quality. See page 

5.2.
• Remove the toner cartridge and install a new 

one. See page 8.4.

Vertical 
repetitive 
defects

If marks repeatedly appear on the printed side of 
the page at even intervals:
• The toner cartridge may be damaged. If a 

repetitive mark occurs on the page, install a 
new toner cartridge. See page 8.4.

• Parts of the printer may have toner on them. If 
the defects occur on the back of the page, the 
problem will likely correct itself after a few 
more pages.

• The fusing assembly may be damaged. 
Contact a service representative.

Condition Suggested solutions

Background 
scatter

Background scatter results from bits of toner 
distributed on the printed page. 
• The paper may be too damp. Try printing with 

a different batch of paper. Do not open 
packages of paper until necessary so that the 
paper does not absorb too much moisture.

• If background scatter occurs on an envelope, 
change the printing layout to avoid printing 
over areas that have overlapping seams on 
the reverse side. Printing on seams can cause 
problems.

• If background scatter covers the entire 
surface area of a printed page, adjust the print 
resolution through your software application or 
via the printer properties window.

Misformed 
characters

• If characters are improperly formed and 
producing hollowed images, the paper stock 
may be too slick. Try a different paper. See 
page 5.3.

Page skew • Ensure that the paper is loaded properly.
• Check the paper type and quality. See page 

5.2.
• Ensure that the paper is loaded correctly and 

the adjustable guides are not too tight or too 
loose against the paper stack.

Curl or wave • Ensure that the paper is loaded properly.
• Check the paper type and quality. Both high 

temperature and humidity can cause paper 
curl. See page 5.2.

• Turn over the stack of paper in the tray. Also 
try rotating the paper 180° in the tray.

Condition Suggested solutions
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Wrinkles or 
creases

• Ensure that the paper is loaded properly.
• Check the paper type and quality. See page 

5.2.
• Turn over the stack of paper in the tray. Also 

try rotating the paper 180° in the tray.

Back of 
printouts are 
dirty

• The transfer roller may be dirty. See page 8.1.
• Check for leaking toner. Clean the inside of 

the printer. 

Solid black 
pages

• The toner cartridge may not be installed 
properly. Remove the cartridge and reinsert.

• The toner cartridge may be defective and 
need replacing. Install a new toner cartridge.

• The printer may require repair. Contact a 
service representative.

Loose toner • Clean the inside of the printer. 
• Check the paper type and quality. See page 

5.2.
• Install a new toner cartridge. See page 8.4.
• If the problem persists, the printer may require 

repair. Contact a service representative.

Character voids Character voids are white areas within 
characters that should be solid black:
• If you are using transparencies, try another 

type of transparency. Because of the 
composition of the transparency, some 
character voids may be normal. 

• You may be printing on the wrong surface on 
the paper. Turn over the paper in the tray. 

• The paper may not meet paper specifications. 
See page 5.3.

Condition Suggested solutions

Common Windows problems

Horizontal 
stripes

If horizontally aligned black streaks or smears 
appear:
• The toner cartridge may be installed 

improperly. Remove the cartridge and 
reinsert.

• The toner cartridge may be defective. Install a 
new toner cartridge. See page 8.4.

• If the problem persists, the printer may require 
repair. Contact a service representative.

Curl If the printed paper is curled or paper does not 
feed into the printer:
• Turn over the stack of paper in the tray. Also 

try rotating the paper 180° in the tray.

An unknown 
image repetitively 
appears on a 
next few sheets 
or loose toner, 
light print or 
contamination 
occurs.

Your printer is probably being used at an altitude 
of 1,000 m (3,281 ft) or above.
The high altitude may affect the print quality 
such as loose toner or light imaging. You can set 
this option through Printer Settings Utility or 
Printer tab in printer driver’s properties. See 
page 1.5.

Condition Suggested solutions

“File in Use” 
message appears 
during installation.

Exit all software applications. Remove all 
software from the StartUp Group, then restart 
Windows. Reinstall the printer driver.

“General Protection 
Fault”, “Exception 
OE”, “Spool32”, or 
“Illegal Operation” 
messages appear.

Close all other applications, reboot Windows, 
and try printing again.

“Fail To Print”, “A 
printer timeout error 
occurred,” 
messages appear.

These messages may appear during printing. 
Just keep waiting until the printer finishes 
printing. If the message appears in standby 
mode or after printing has been completed, 
check the connection and/or whether an error 
has occurred.

Note
• Refer to Microsoft Windows 2000/XP/Vista and Windows 

Server 2003 User’s Guide that came with your PC for further 
information on Windows error messages.

Condition Suggested solutions
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Common PostScript problems
The following situations are PostScript language specific and may occur 
when several printer languages are being used.

Note
• To receive a printed or screen displayed message when 

PostScript errors occur, open the Print Options window and 
click the desired selection next to the PostScript errors section.

Condition Possible cause Suggested solutions

PostScript file 
can not be 
printed.

The PostScript 
driver may not 
be installed 
correctly.

• Print a configuration page 
and verify that the PostScript 
version is available for 
printing.

• Install the PostScript driver; 
to installing the PS printer 
driver, see the Software 
Section.

• If problem consists, contact a 
service representative.

“Limit Check 
Error” message 
appears.

The print job 
was too 
complex.

You might need to reduce the 
complexity of the page.

A PostScript 
error page 
prints.

Print job may 
not be 
PostScript.

Make sure that the print job is a 
PostScript job. Check to see 
whether the software 
application expected a setup or 
PostScript header file to be sent 
to the printer.

When print a 
document in 
Macintosh with 
Acrobat Reader 
6.0 or higher, 
colors print 
incorrectly.

The resolution 
setting in the 
printer driver 
may not be 
matched with 
that in Acrobat 
Reader.

Make sure that the resolution 
setting in your printer driver 
matches that in Acrobat 
Reader.

Common Macintosh problems

Condition Suggested solutions

The printer does not 
print PDF file correctly. 
Some parts of graphics, 
text, or illustrations are 
missing.

Incompatibility between the PDF file and 
the Acrobat products:
Printing the PDF file as an image may 
solve this problem. Turn on Print As 
Image from the Acrobat printing options.
Note: It will take longer to print when you 
print a PDF file as an image.

The document has 
printed, but the print job 
has not disappeared 
from the spooler in Mac 
OS 10.3.2.

Update your Mac OS to OS 10.3.3 or 
higher.

Some letters are not 
displayed normally 
during the cover sheet 
printing.

This problem is caused because Mac OS 
cannot find the font during the cover 
page printing. 
Alphanumeric characters, in the Billing 
Info field, are only allowed for printing on 
the cover page. Other characters will be 
broken on the printout.
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10 Installing accessories
Your machine is a full-featured model that has been optimized to meet 
most of your printing needs. Recognizing that each user may have 
different requirements, however, manufacturer makes several 
accessories available to enhance your machine’s capabilities.

This chapter includes:
• Precautions to take when installing accessories
• Installing a memory module

Precautions to take when installing accessories

Disconnect the power cord
Never remove the control board cover while the power is turned on.

To avoid the possibility of an electrical shock, always disconnect the 
power cord when installing or removing ANY internal or external 
accessories.

Discharge static electricity
The control board and internal accessories (network interface card or 
memory module) are sensitive to static electricity. Before installing or 
removing any internal accessories, discharge static electricity from your 
body by touching something metal, such as the metal back plate on any 
device plugged into a grounded power source. If you walk around before 
finishing the installation, repeat this procedure to discharge any static 
electricity again.

Installing a memory module
Your machine has a dual in-line memory module (DIMM). Use this 
memory module slot to install additional memory.

When you are expanding the memory capacity, you can add a memory 
module to the vacant memory slot. Your machine has 32 MB memory, 
and you can add a 128 MB memory module.

1 Turn the machine off and unplug all cables from the machine.

2 Open the control board cover.

3 Take out a new memory module from the plastic bag.

4 Holding the memory module by the edges, align the memory 
module on the slot at about a 30-degree tilt. Make sure that the 
notches of the module and the grooves on the slot fit each other.

Note
The notches and grooves illustrated above may not match 
those on an actual memory module and its slot.

5 Press the memory module into the slot with care until you hear a 
“click”. 

Note
Do not press the memory module strongly or the module 
may be damaged. If the module does not seem to fit into 
the slot properly, carefully try the previous procedure again.

6 Replace the control board cover.

7 Reconnect the power cord and printer cable, and turn the machine 
on.

Note
To release the memory module, pull the two tabs on the 
sides of the slot outwards, then the module springs out. 

Download from Www.Somanuals.com. All Manuals Search And Download.



10.2   <Installing accessories>

Activating the added memory in the PS printer 
properties
After installing the memory module, you need to select it in the printer 
properties of the PostScript printer driver in order to use it.

1 Make sure that the PostScript printer driver is installed on your 
computer. For details about installing the PS printer driver, see 
Software section.

2 Click the Windows Start menu.

3 For Windows 2000, select Settings and then Printers.

For Windows XP and Windows Server 2003, select Printers and 
Faxes.

For Windows Vista, select Control Panel > Hardware and Sound 
> Printers.

4 Select the SP 3300 Series PS printer.

5 Click the right mouse button on the printer icon and select 
Properties.

6 For Windows 2000/XP/0Vista and Windows Server 2003, select 
Device Settings.

7 Select the amount of memory you installed from Printer Memory in 
the Installable Options section.

8 Click OK.
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11 Specifications

Printer specifications

Item Specifications and description

Printing speeda Up to 28 ppm in A4 (30 ppm in Letter)
Duplex: 14 ipm in A4 (14.5 ipm in Letter)

Resolution Up to 1200 x 1200 dpi effective output

Warm-up time Less than 15 seconds (From sleep mode)

First print out 
time

8.5 seconds (From Ready)
Sleep mode: 25 seconds

Power rating AC 110-127 V or AC 220-240 V
See the Rating label on the machine for the 
correct voltage, frequency (hertz) and type of 
current for your machine.

Power 
consumption

Average: 500 W 
Power save mode: Less than 11 W 

Noise levelb Standby mode: Less than 26 dBA
Printing mode: Less than 50 dBA

Toner cartridge 
lifec

Average cartridge yield 5,000 standard pagesd.
(Ships with 2,000 pages Starter/Standard Toner 
Cartridge)    

Duty cycle Monthly: Up to 50,000 pages

Weight 11.9 Kg (including consumables)

Package weight Paper: 2.4 Kg, Plastic: 0.3 Kg

Memory 32 MB (Max. 160 MB)

128 MB optional memory available

External 
dimensions
(W x D x H)

364 x 369 x 210 mm (14.3 x 14.5 x 8.3 inches) 

Operating 
environment

Temperature: 10 to 32°C (50 to 90°F)
Humidity: 20 to 80% RH

Printer language PCL6e, PostScript 3

Fonts 1 bitmap, 45 scalable, 136 PostScript 3 fonts

Interface • USB Interface Standard
   - USB 2.0: Hi-Speed USB 2.0
• Network Interface Standard (SP 3300DN only)
   - Ethernet 10/100 Base TX wired LAN 

OS compatibility • Windows 2000/XP (32/64 bit)/Vista and Windows 
Server 2003

• Mac OS 8.6~9.2, 10.1~10.5

Printer drivers • PCL6 driver: Windows 2000/XP (32/64 bit)/Vista 
and Windows Server 2003

• PostScript driver: Windows 2000/XP (32/64 bit)/
Vista and Windows Server 2003, Mac OS 
8.6~9.2, 10.1~10.5

Options 250-sheet tray, DIMM

Fusing 
temperature

180° C (356° F)

a. Print speed will be affected by operating system used, computing 
performance, application software, connection method, print media type, print 
media size, and job complexity.

b. Sound pressure Level, ISO7779.
c. The number of pages may be affected by operating environment, printing 

interval, print media type, and print media size.
d. Declared yield value in accordance with ISO/IEC 19752.
e. Compatible with PCL6 version 2.1.

Item Specifications and description
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1 Installing Printer Software in 
Windows
This chapter includes:

• Installing Printer Software

• Reinstalling Printer Software

• Removing Printer Software

NOTE: The following procedure is based on Windows XP, for other 
operating systems, refer to the corresponding Windows user's guide 
or online help.

Installing Printer Software
You can install the printer software for local printing or network printing. 
To install the printer software on the computer, perform the appropriate 
installation procedure depending on the printer in use.

A printer driver is software that lets your computer communicate with 
your printer. The procedure to install drivers may differ depending on the 
operating system you are using.

All applications should be closed on your PC before beginning 
installation. 

Installing Software for Local Printing
A local printer is a printer directly attached to your computer using the 
printer cable supplied with your printer, such as a USB or parallel cable. 
If your printer is attached to a network, skip this step and go to “Installing 
Software for Network Printing” on page 6.

You can install the printer software using the typical or custom method.

NOTE: If the “New Hardware Wizard” window appears during the 
installation procedure, click  in the upper right corner of the box 
to close the window, or click Cancel.

Typical Installation

This is recommended for most users. All components necessary for 
printer operations will be installed.

1 Make sure that the printer is connected to your computer and 
powered on.

2 Insert the supplied CD-ROM into your CD-ROM drive.
The CD-ROM should automatically run, and an installation 
window appears.
If the installation window does not appear, click Start and then 
Run. Type X:\Setup.exe, replacing “X” with the letter which 
represents your drive and click OK.
If you use Windows Vista, click Start → All programs → 
Accessories → Run, and type X:\Setup.exe.
If the AutoPlay window appears in Windows Vista, click Run 
Setup.exe in Install or run program field, and click Continue 
in the User Account Control window.

3 Click Next. 

• If necessary, select a language from the drop-down list.
• View User’s Guide: Allows you to view the User’s Guide. If 

your computer doesn’t have Adobe Acrobat, click on this 
option and it will automatically install Adobe Acrobat Reader 
for you.
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4 Select Typical installation for a local printer. Click Next.

NOTE: If your printer is not already connected to the computer, the 
following window will appear.

• After connecting the printer, click Next.
• If you don’t want to connect the printer at this time, click Next, and 

No on the following screen. Then the installation will start and a 
test page will not be printed at the end of the installation.

• The installation window that appears in this User’s Guide may 
differ depending on the interface in use.

5 After the installation is finished, a window asking you to print a 
test page appears. If you choose to print a test page, select the 
checkbox and click Next.
Otherwise, just click Next and skip to step 7.

6 If the test page prints out correctly, click Yes.

If not, click No to reprint it.

7 Click Finish.

NOTE: After setup is complete, if your printer driver doesn’t work 
properly, reinstall the printer driver. See “Reinstalling Printer 
Software” on page 9.

Custom Installation

You can choose individual components to install.

1 Make sure that the printer is connected to your computer and 
powered on.

2 Insert the supplied CD-ROM into your CD-ROM drive.
The CD-ROM should automatically run, and an installation 
window appears.
If the installation window does not appear, click Start and then 
Run. Type X:\Setup.exe, replacing “X” with the letter which 
represents your drive and click OK.
If you use Windows Vista, click Start → All programs → 
Accessories → Run, and type X:\Setup.exe.
If the AutoPlay window appears in Windows Vista, click Run 
Setup.exe in Install or run program field, and click Continue 
in the User Account Control window.
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3 Click Next. 

• If necessary, select a language from the drop-down list.
• View User’s Guide: Allows you to view the User’s Guide. If 

your computer doesn’t have Adobe Acrobat, click on this 
option and it will automatically install Adobe Acrobat Reader 
for you.

4 Select Custom installation. Click Next.

5 Select your printer and click Next.

NOTE: If your printer is not already connected to the computer, the 
following window will appear.

• After connecting the printer, click Next.
• If you don’t want to connect the printer at this time, click Next, and 

No on the following screen. Then the installation will start and a 
test page will not be printed at the end of the installation.

• The installation window that appears in this User’s Guide may 
differ depending on the interface in use.

6 Select the components to be installed and click Next.

NOTE: You can change the desired installation folder by clicking 
[Browse].

7 After the installation is finished, a window asking you to print a 
test page appears. If you choose to print a test page, select the 
checkbox and click Next.
Otherwise, just click Next and skip to step 9.

8 If the test page prints out correctly, click Yes.

If not, click No to reprint it.

Download from Www.Somanuals.com. All Manuals Search And Download.



Installing Printer Software in Windows
6

9 Click Finish.

Installing Software for Network Printing
When you connect your printer to a network, you must first configure the 
TCP/IP settings for the printer. After you have assigned and verified the 
TCP/IP settings, you are ready to install the software on each computer 
on the network.

You can install the printer software using the typical or custom method.

Typical Installation

This is recommended for most users. All components necessary for 
printer operations will be installed.

1 Make sure that the printer is connected to your network and 
powered on. For details about connecting to the network, see 
the supplied printer’s User’s Guide.

2 Insert the supplied CD-ROM into your CD-ROM drive.
The CD-ROM should automatically run, and an installation 
window appears.
If the installation window does not appear, click Start and then 
Run. Type X:\Setup.exe, replacing “X” with the letter which 
represents your drive and click OK.
If you use Windows Vista, click Start → All programs → 
Accessories → Run, and type X:\Setup.exe.
If the AutoPlay window appears in Windows Vista, click Run 
Setup.exe in Install or run program field, and click Continue 
in the User Account Control window.

3 Click Next. 

• If necessary, select a language from the drop-down list.
• View User’s Guide: Allows you to view the User’s Guide. If 

your computer doesn’t have Adobe Acrobat, click on this 
option and it will automatically install Adobe Acrobat Reader 
for you.

4 Select Typical installation for a network printer. Click Next.

5 The list of printers available on the network appears. Select the 
printer you want to install from the list and then click Next. 
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• If you do not see your printer on the list, click Update to 
refresh the list, or select Add TCP/IP Port to add your printer 
to the network. To add the printer to the network, enter the 
port name and the IP address for the printer.

To verify your printer’s IP address or the MAC address, print a 
Network Configuration page.

• To find a shared network printer (UNC Path), select Shared 
Printer [UNC] and enter the shared name manually or find a 
shared printer by clicking the Browse button.

NOTE: If you cannot find your machine in network, please turn off 
the firewall and click Update.
For Windows operating system, click Start → Control Panel and 
start windows firewall, and set this option unactivated. For other 
operating system, refer to its on-line guide.

6 After the installation is finished, a window appears asking you to 
print a test page. If you so desire, select the corresponding 
checkbox and click Finish.
Otherwise, just click Finish. 

NOTE: After setup is complete, if your printer driver doesn’t work 
properly, reinstall the printer driver. See “Reinstalling Printer 
Software” on page 9.

Custom Installation

You can choose individual components to install and set a specific IP 
address.

1 Make sure that the printer is connected to your network and 
powered on. For details about connecting to the network, see 
the supplied printer’s User’s Guide.

2 Insert the supplied CD-ROM into your CD-ROM drive.
The CD-ROM should automatically run, and an installation 
window appears.

If the installation window does not appear, click Start and then 
Run. Type X:\Setup.exe, replacing “X” with the letter which 
represents your drive and click OK.
If you use Windows Vista, click Start → All programs → 
Accessories → Run, and type X:\Setup.exe.
If the AutoPlay window appears in Windows Vista, click Run 
Setup.exe in Install or run program field, and click Continue 
in the User Account Control window.

3 Click Next. 

• If necessary, select a language from the drop-down list.
• View User’s Guide: Allows you to view the User’s Guide. If 

your computer doesn’t have Adobe Acrobat, click on this 
option and it will automatically install Adobe Acrobat Reader 
for you.

4 Select Custom installation. Click Next.
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5 The list of printers available on the network appears. Select the 
printer you want to install from the list and then click Next. 

• If you do not see your printer on the list, click Update to 
refresh the list, or select Add TCP/IP Port to add your printer 
to the network. To add the printer to the network, enter the 
port name and the IP address for the printer.

To verify your printer’s IP address or the MAC address, print a 
Network Configuration page.

• To find a shared network printer (UNC Path), select Shared 
Printer [UNC] and enter the shared name manually or find a 
shared printer by clicking the Browse button.

NOTE: If you cannot find your machine in network, please turn off 
the firewall and click Update.
For Windows operating system, click Start → Control Panel and 
start windows firewall, and set this option unactivated. For other 
operating system, refer to its on-line guide.

TIP: If you want to set a specific IP address on a specific network 
printer, click the Set IP Address button. The Set IP Address window 
appears. Do as follows:

a. Select a printer to be set with a specific IP address from the list.

b. Configure an IP address, subnet mask, and gateway for the 
printer manually and click Configure to set the specific IP 
address for the network printer.

c. Click Next.

6 Select the components to be installed and click Next.

NOTE: You can change the desired installation folder by clicking 
[Browse].

7 Select the components to be installed. After selecting the 
components, the following window appears. You can also 
change the printer name, set the printer to be shared on the 
network, set the printer as the default printer, and change the 
port name of each printer. Click Next.

To install this software on a server, select the Setting up this 
printer on a server checkbox.

8 After the installation is finished, a window appears asking you to 
print a test page. If you so desire, select the corresponding 
checkbox and click Finish.
Otherwise, just click Finish. 
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NOTE: After setup is complete, if your printer driver doesn’t work 
properly, reinstall the printer driver. See “Reinstalling Printer 
Software” on page 9.

Reinstalling Printer Software
You can reinstall the software if installation fails.

1 Start Windows.

2 From the Start menu select Programs or All Programs → 
SP 3300 Series → Maintenance.

3 Select Repair and click Next.

4 The list of printers available on the network appears. Select the 
printer you want to install from the list and then click Next. 

• If you do not see your printer on the list, click Update to 
refresh the list, or select Add TCP/IP Port to add your printer 
to the network. To add the printer to the network, enter the 
port name and the IP address for the printer.

• To find a shared network printer (UNC Path), select Shared 
Printer [UNC] and enter the shared name manually or find a 
shared printer by clicking the Browse button.

You will see a component list so that you can reinstall any item 
individually.

NOTE: If your printer is not already connected to the computer, the 
following window will appear.

• After connecting the printer, click Next.
• If you don’t want to connect the printer at this time, click Next, and 

No on the following screen. Then the installation will start and a 
test page will not be printed at the end of the installation.

• The reinstallation window that appears in this User’s Guide may 
differ depending on the interface in use.

5 Select the components you want to reinstall and click Next.
If you installed the printer software for local printing and you 
select SP 3300 Series, the window asking you to print a test 
page appears. Do as follows:
a. To print a test page, select the check box and click Next.
b. If the test page prints out correctly, click Yes.

If it doesn’t, click No to reprint it.

6 When the reinstallation is done, click Finish.
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Removing Printer Software
1 Start Windows.

2 From the Start menu select Programs or All Programs → 
SP 3300 Series → Maintenance.

3 Select Remove and click Next.
You will see a component list so that you can remove any item 
individually.

4 Select the components you want to remove and then click 
Next.

5 When your computer asks you to confirm your selection, click 
Yes.
The selected driver and all of its components are removed from 
your computer.

6 After the software is removed, click Finish.
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2 Basic Printing 
This chapter explains the printing options and common printing tasks 
in Windows. 

This chapter includes:

• Printing a Document

• Printing to a file (PRN)

• Printer Settings

- Layout Tab

- Paper Tab

- Graphics Tab

- Extras Tab

- About Tab

- Printer Tab

- Using a Favorite Setting

- Using Help

Printing a Document

NOTES: 
• Your printer driver Properties window that appears in this User’s 

Guide may differ depending on the printer in use. However the 
composition of the printer properties window is similar.

• Check the Operating System(s) that are compatible with your 
printer. Please refer to the OS Compatibility section of Printer 
Specifications in your Printer User’s Guide.

• If you need to know the exact name of your printer, you can check 
the supplied CD-ROM.

The following procedure describes the general steps required for printing 
from various Windows applications. The exact steps for printing a 
document may vary depending on the application program you are 
using. Refer to the User’s Guide of your software application for the 
exact printing procedure.

1 Open the document you want to print.

2 Select Print from the File menu. The Print window is displayed. 
It may look slightly different depending on your application. 
The basic print settings are selected within the Print window. 
These settings include the number of copies and print range.

3 Select your printer driver from the Name drop-down list.
To take advantage of the printer features provided by your 
printer driver, click Properties or Preferences in the 
application’s Print window. For details, see “Printer Settings” on 
page 12.
If you see Setup, Printer, or Options in your Print window, click 
it instead. Then click Properties on the next screen.
Click OK to close the printer properties window.

4 To start the print job, click OK or Print in the Print window.

Make sure that your 
printer is selected.
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Printing to a file (PRN)
You will sometimes need to save the print data as a file for your purpose. 

To create a file:

1 Check the Print to file box at the Print window.

2 Select the folder and assign a name of the file and then click 
OK.

Printer Settings
You can use the printer properties window, which allows you to access 
all of the printer options you need when using your printer. When the 
printer properties are displayed, you can review and change the settings 
needed for your print job. 

Your printer properties window may differ, depending on your operating 
system. This Software User’s Guide shows the Properties window for 
Windows XP.

Your printer driver Properties window that appears in this User’s Guide 
may differ depending on the printer in use.

If you access printer properties through the Printers folder, you can view 
additional Windows-based tabs (refer to your Windows User’s Guide) 
and the Printer tab (see “Printer Tab” on page 16).

NOTES:
• Most Windows applications will override settings you specify in 

the printer driver. Change all print settings available in the 
software application first, and change any remaining settings 
using the printer driver. 

• The settings you change remain in effect only while you are using 
the current program. To make your changes permanent, make 
them in the Printers folder. 

• The following procedure is for Windows XP. For other Windows 
OS, refer to the corresponding Windows User's Guide or online 
help.
1.Click the Windows Start button.
2.Select Printers and Faxes.
3.Select your printer driver icon.
4.Right-click on the printer driver icon and select 

Printing Preferences.
5.Change the settings on each tab, click OK.
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Layout Tab
The Layout tab provides options to adjust how the document appears 
on the printed page. The Layout Options includes Multiple Pages 
per Side, Poster Printing and Booklet Printing. See “Printing a 
Document” on page 11 for more information on accessing printer 
properties. 

Paper Orientation
Paper Orientation allows you to select the direction in which 
information is printed on a page. 
• Portrait prints across the width of the page, letter style. 
• Landscape prints across the length of the page, spreadsheet 

style. 
• Rotate allows you to rotate the page the selected degrees.

Layout Options
Layout Options allows you to select advanced printing options. You 
can choose Multiple Pages per Side and Poster Printing.
• For details, see “Printing Multiple Pages on One Sheet of Paper 

(N-Up Printing)” on page 17.
• For details, see “Printing Posters” on page 18
• For details, see “Printing Booklets” on page 18

Double-sided Printing
Double-sided Printing allows you to print on both sides of paper. 
• For details, see “Printing on Both Sides of Paper” on page 19.

 Landscape Portrait

Paper Tab
Use the following options to set the basic paper handling specifications 
when you access the printer properties. See “Printing a Document” on 
page 11 for more information on accessing printer properties. 

Click the Paper tab to access various paper properties. 

Copies
Copies allows you to choose the number of copies to be printed. 
You can select 1 to 999 copies. 

Paper Options

Size
Size allows you to set the size of paper you loaded in the tray. 
If the required size is not listed in the Size box, click Custom. When 
the Custom Paper Setting window appears, set the paper size and 
click OK. The setting appears in the list so that you can select it. 

Source
Make sure that Source is set to the corresponding paper tray.
Use Manual Feeder when printing on special materials like 
envelopes and transparencies. You have to load one sheet at a time 
into the Manual Feeder.
If the paper source is set to Auto Select, the printer automatically 
picks up print material in the following tray order: Manual Feeder, 
Tray 1, optional Tray 2.

Type
Set Type to correspond to the paper loaded in the tray from which 
you want to print. This will let you get the best quality printout. If not, 
print quality may not be acheived as you want.
Cotton: 20 lb to 24 lb (75~90 g/m2) cotton paper such as Gilbert 
25% and Gilbert 100%. 
Plain: Normal plain paper. Select this type if your printer is 
monochrome and printing on the 16 lb (60 g/m2) cotton paper. 
Recycled: 20 lb to 24 lb (75~90 g/m2) recycled paper.
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Color: 20 lb to 24 lb (75~90 g/m2) color-backgrounded paper.
Archive: If you need to keep print-out for a long period time such as 
archives, select this option.

First Page 
This property allows you to print the first page using a different 
paper type from the rest of the document. You can select the paper 
source for the first page. 
For example, load thick stock for the first page into the Manual 
Feeder, and plain paper into Tray 1. Then, select Tray1 in the 
Source option and Manual Feeder in the First Page option.

Scaling Printing
Scaling Printing allows you to automatically or manually scale your 
print job on a page. You can choose from None, Reduce/Enlarge, 
and Fit to Page. 
• For details, see “Printing a Reduced or Enlarged Document” on 

page 19.
• For details, see “Fitting Your Document to a Selected Paper Size” 

on page 19.

Graphics Tab
Use the following Graphic options to adjust the print quality for your 
specific printing needs. See “Printing a Document” on page 11 for more 
information on accessing printer properties. 

Click the Graphic tab to display the properties shown below. 

Resolution
The higher the setting, the sharper the clarity of printed characters 
and graphics. The higher setting also may increase the time it takes 
to print a document. 

Image Mode
The available options are Normal and Text Enhancement. 
• Printer Setting: If you select this option, this feature is 

determined by the setting you’ve made on the control panel of the 
printer. 

• Normal: This setting is for normal documents.
• Text Enhancement: Image Mode allows the user to enhance 

printouts. 

Toner Save Mode
Selecting this option extends the life of your toner cartridge and 
reduces your cost per page without a significant reduction in print 
quality. 
• Printer Setting: If you select this option, this feature is 

determined by the setting you’ve made on the control panel of the 
printer. 

• On: Select this option to allow the printer to use less toner on 
each page.

• Off: If you don’t need to save toner when printing a document, 
select this option.
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Advanced Options

You can set advanced settings by clicking the Advanced Options 
button. 
• TrueType Options: This option determines what the driver tells 

the printer about how to image the text in your document. Select 
the appropriate setting according to the status of your document.
- Download as Outline: When this option is selected, the driver 

will download any TrueType fonts that are used in your 
document not already stored (resident) on your printer. If, after 
printing a document, you find that the fonts did not print 
correctly, choose Download as bit image and resubmit your print 
job. The Download as bit image setting is often useful when 
printing Adobe. 

- Download as Bitmap: When this option is selected, the driver 
will download the font data as bitmap images. Documents with 
complicated fonts, such as Korean or Chinese, or various other 
fonts, will print faster in this setting. 

- Print as Graphics: When this option is selected, the driver will 
download any fonts as graphics. When printing documents with 
high graphic content and relatively few TrueType fonts, printing 
performance (speed) may be enhanced in this setting.

• Print All Text To Black: When the Print All Text To Black option 
is checked, all text in your document prints solid black, regardless 
of the color it appears on the screen. 

Extras Tab
You can select output options for your document. See “Printing a 
Document” on page 11 for more information about accessing the printer 
properties.

Click the Extras tab to access the following feature: 

Watermark
You can create a background text image to be printed on each page 
of your document. For details, see “Using Watermarks” on page 20.

Overlay
Overlays are often used to take the place of preprinted forms and 
letterhead paper. For details, see “Using Overlays” on page 21.

Output Options
• Print Subset: You can set the sequence in which the pages print. 

Select the print order from the drop-down list.
- Normal (1,2,3): Your printer prints all pages from the first page to 

the last page.
- Reverse All Pages (3,2,1): Your printer prints all pages from the 

last page to the first page.
- Print Odd Pages: Your printer prints only the odd numbered 

pages of the document.
- Print Even Pages: Your printer prints only the even numbered 

pages of the document.
• Use Printer Fonts: When Use Printer Fonts is checked, the 

printer uses the fonts that are stored in its memory (resident fonts) 
to print your document, rather than downloading the fonts used in 
your document. Because downloading fonts takes time, selecting 
this option can speed up your printing time. When using Printer 
fonts, the printer will try to match the fonts used in your document 
to those stored in its memory. If, however, you use fonts in your 
document that are very different from those resident in the printer, 
your printed output will appear very different from what it looks like 
on the screen. 
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About Tab
Use the About tab to display the copyright notice and the version 
number of the driver. See “Printing a Document” on page 11 for more 
information about accessing printer properties.

Printer Tab
If you access printer properties through the Printers folder, you can view 
the Printer tab. You can set the printer configuration.

The following procedure is for Windows XP. For other Windows OS, refer 
to the corresponding Windows User's Guide or online help.

1 Click the Windows Start menu. 

2 Select Printers and Faxes.

3 Select your printer driver icon. 

4 Right-click on the printer driver icon and select Properties.

5 Click the Printer tab and set the options. 

Using a Favorite Setting 
The Favorites option, which is visible on each properties tab, allows you 
to save the current properties settings for future use. 

To save a Favorites item:
1 Change the settings as needed on each tab. 

2 Enter a name for the item in the Favorites input box. 

3 Click Save. 
When you save Favorites, all current driver settings are saved.

To use a saved setting, select the item from the Favorites drop down 
list. The printer is now set to print according to the Favorites setting you 
selected. 

To delete a Favorites item, select it from the list and click Delete. 

You can also restore the printer driver’s default settings by selecting 
Printer Default from the list. 

Using Help
Your printer has a help screen that can be activated by clicking the Help 
button in the printer properties window. These help screens give detailed 
information about the printer features provided by the printer driver.

You can also click  from the upper right corner of the window, and 
then click on any setting. 
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3 Advanced Printing
This chapter explains printing options and advanced printing tasks. 

NOTE: 
• Your printer driver Properties window that appears in this User’s 

Guide may differ depending on the printer in use. However the 
composition of the printer properties window is similar.

• If you need to know the exact name of your printer, you can check 
the supplied CD-ROM.

This chapter includes:

• Printing Multiple Pages on One Sheet of Paper (N-Up 
Printing)

• Printing Posters

• Printing Booklets

• Printing on Both Sides of Paper

• Printing a Reduced or Enlarged Document

• Fitting Your Document to a Selected Paper Size

• Using Watermarks

• Using Overlays

Printing Multiple Pages on One Sheet 
of Paper (N-Up Printing) 
You can select the number of pages to print on a single sheet of paper. 
To print more than one page per sheet, the pages will be reduced in size 
and arranged in the order you specify. You can print up to 16 pages on 
one sheet. 
1 To change the print settings from your software application, 

access printer properties. See “Printing a Document” on 
page 11.

2 From the Layout tab, choose Multiple Pages per Side in the 
Layout Type drop-down list. 

3 Select the number of pages you want to print per sheet 
(1, 2, 4, 6, 9, or 16) in the Pages per Side drop-down list.

4 Select the page order from the Page Order drop-down list, if 
necessary. 
Check Print Page Border to print a border around each page 
on the sheet. 

5 Click the Paper tab, select the paper source, size, and type.

6 Click OK and print the document. 

1 2

3 4
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Printing Posters
This feature allows you to print a single-page document onto 4, 9, or 16 
sheets of paper, for the purpose of pasting the sheets together to form 
one poster-size document.

NOTE: The poster printing option is available when 600 dpi is 
selected in the resolution option on the Graphic tab.

1 To change the print settings from your software application, 
access printer properties. See “Printing a Document” on 
page 11.

2 Click the Layout tab, select Poster Printing in the Layout 
Type drop-down list.

3 Configure the poster option:
You can select the page layout from Poster<2x2>, 
Poster<3x3>, Poster<4x4> or Custom. If you select 
Poster<2x2>, the output will be automatically stretched to 
cover 4 physical pages. If the option is set to Custom, you can 
enlarge the original from 150% to 400%. Depending on the level 
of the enlargement, the page layout is automatically adjusted to 
Poster<2x2>, Poster<3x3>, Poster<4x4>. 

Specify an overlap in millimeters or inches to make it easier to 
pasting the sheets together. 

4 Click the Paper tab, select the paper source, size, and type.

5 Click OK and print the document. You can complete the poster 
by pasting the sheets together. 

0.15 inches

0.15 inches

Printing Booklets

This printer feature allows you to print your document on both sides of 
the paper and arranges the pages so that the paper can be folded in half 
after printing to produce a booklet. 

1 To change the print settings from your software application, 
access the printer properties. See “Printing a Document” on 
page 11.

2 From the Layout tab, choose Booklet Printing from the 
Layout Type drop-down list. 

NOTE: The Booklet Printing option is not available for all paper 
sizes. In order to find out the available paper size for this feature, 
select the paper size in the Size option on the Paper tab, then check 
if the Booklet Printing in a Layout Type drop-down list on the 
Layout tab is activated.

3 Click the Paper tab, and select the paper source, size, and 
type.

4 Click OK and print the document.

5 After printing, fold and staple the pages. 

8 9
8 9
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Printing on Both Sides of Paper
You can print on both sides of a sheet of paper. Before printing, decide 
how you want your document oriented.

The options are:
• Printer Setting, if you select this option, this feature is 

determined by the setting you’ve made on the control panel of the 
printer. 

• None
• Long Edge, which is the conventional layout used in book 

binding.
• Short Edge, which is the type often used with calendars.

• Reverse Duplex Printing, allows you to select general print 
order compare to duplex print order. 

NOTE: Do not print on both sides of labels, transparencies, 
envelopes, or thick paper. Paper jamming and damage to the printer 
may result. 

1 To change the print settings from your software application, 
access printer properties. “Printing a Document” on page 11.

2 From the Layout tab, select the paper orientation.

3 From the Double-sided Printing section, select the binding 
option you want.     

4 Click the Paper tab and select the paper source, size, and type.

5 Click OK and print the document.

 Long Edge▲  Short Edge▲

2 5
3

2

5
3

2 5
3

2

5
3

Printing a Reduced or Enlarged 
Document 
You can change the size of a page’s content to appear larger or smaller 
on the printed page. 
1 To change the print settings from your software application, 

access printer properties. See “Printing a Document” on 
page 11. 

2 From the Paper tab, select Reduce/Enlarge in the Printing 
Type drop-down list. 

3 Enter the scaling rate in the Percentage input box.
You can also click the  or  button.

4 Select the paper source, size, and type in Paper Options. 

5 Click OK and print the document. 

Fitting Your Document to a Selected 
Paper Size
This printer feature allows you to scale your print job to any selected 
paper size regardless of the digital document size. This can be useful 
when you want to check fine details on a small document. 
1 To change the print settings from your software application, 

access printer properties. See “Printing a Document” on 
page 11.

2 From the Paper tab, select Fit to Page in the Printing Type 
drop-down list. 

3 Select the correct size from the Output size drop-down list.

4 Select the paper source, size, and type in Paper Options.

5 Click OK and print the document.

A

Download from Www.Somanuals.com. All Manuals Search And Download.



Advanced Printing
20

Using Watermarks
The Watermark option allows you to print text over an existing document. 
For example, you may want to have large gray letters reading “DRAFT” 
or “CONFIDENTIAL” printed diagonally across the first page or all pages 
of a document. 

There are several predefined watermarks that come with the printer, and 
they can be modified, or you can add new ones to the list. 

Using an Existing Watermark
1 To change the print settings from your software application, 

access printer properties. See “Printing a Document” on 
page 11. 

2 Click the Extras tab, and select the desired watermark from the 
Watermark drop-down list. You will see the selected watermark 
in the preview image. 

3 Click OK and start printing. 

NOTE: The preview image shows how the page will look when it is 
printed.

Creating a Watermark
1 To change the print settings from your software application, 

access printer properties. See “Printing a Document” on 
page 11. 

2 Click the Extras tab, and click the Edit button in the Watermark 
section. The Edit Watermark window appears. 

3 Enter a text message in the Watermark Message box. You can 
enter up to 40 characters. The message displays in the preview 
window.
When the First Page Only box is checked, the watermark 
prints on the first page only.

4 Select watermark options. 
You can select the font name, style, size, or grayscale level 
from the Font Attributes section and set the angle of the 
watermark from the Message Angle section. 

5 Click Add to add a new watermark to the list.   

6 When you have finished editing, click OK and start printing. 

To stop printing the watermark, select (No Watermark) from the 
Watermark drop-down list. 

Editing a Watermark
1 To change the print settings from your software application, 

access printer properties. See “Printing a Document” on 
page 11. 

2 Click the Extras tab and click the Edit button in the Watermark 
section. The Edit Watermark window appears.

3 Select the watermark you want to edit from the Current 
Watermarks list and change the watermark message and 
options. 

4 Click Update to save the changes.

5 Click OK until you exit the Print window. 

Deleting a Watermark
1 To change the print settings from your software application, 

access printer properties. See “Printing a Document” on 
page 11.

2 From the Extras tab, click the Edit button in the Watermark 
section. The Edit Watermark window appears. 

3 Select the watermark you want to delete from the Current 
Watermarks list and click Delete. 

4 Click OK until you exit the Print window.
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Using Overlays

What is an Overlay?
An overlay is text and/or images stored in the computer hard disk drive 
(HDD) as a special file format that can be printed on any document. 
Overlays are often used to take the place of preprinted forms and 
letterhead paper. Rather than using preprinted letterhead, you can 
create an overlay containing the exact same information that is currently 
on your letterhead. To print a letter with your company’s letterhead, you 
do not need to load preprinted letterhead paper in the printer. You need 
only tell the printer to print the letterhead overlay on your document.

Creating a New Page Overlay
To use a page overlay, you must create a new page overlay containing 
your logo or image.
1 Create or open a document containing text or an image for use 

in a new page overlay. Position the items exactly as you wish 
them to appear when printed as an overlay.

2 To save the document as an overlay, access printer properties. 
See “Printing a Document” on page 11.

3 Click the Extras tab, and click Edit button in the Overlay 
section. 

4 In the Edit Overlay window, click Create Overlay. 

5 In the Create Overlay window, type a name of up to eight 
characters in the File name box. Select the destination path, if 
necessary. (The default is C:\Formover).

6 Click Save. The name appears on the Overlay List box. 

7 Click OK or Yes to finish creating. 
The file is not printed. Instead it is stored on your computer hard 
disk drive. 

NOTE: The overlay document size must be the same as the 
documents you print with the overlay. Do not create an overlay with 
a watermark. 

WORLD BEST

Dear ABC

Regards

WORLD BEST

Using a Page Overlay
After an overlay has been created, it is ready to be printed with your 
document. To print an overlay with a document:
1 Create or open the document you want to print. 

2 To change the print settings from your software application, 
access printer properties. See “Printing a Document” on 
page 11. 

3 Click the Extras tab. 

4 Select the desired overlay from the Overlay drop-down list box. 

5 If the overlay file you want does not appear in the Overlay list, 
click Edit button and Load Overlay, and select the overlay file. 
If you have stored the overlay file you want to use in an external 
source, you can also load the file when you access the Load 
Overlay window. 
After you select the file, click Open. The file appears in the 
Overlay List box and is available for printing. Select the overlay 
from the Overlay List box. 

6 If necessary, click Confirm Page Overlay When Printing. If 
this box is checked, a message window appears each time you 
submit a document for printing, asking you to confirm your wish 
to print an overlay on your document. 
If this box is not checked and an overlay has been selected, the 
overlay automatically prints with your document. 

7 Click OK or Yes until printing begins. 
The selected overlay downloads with your print job and prints 
on your document. 

NOTE: The resolution of the overlay document must be the same as 
that of the document you will print with the overlay. 

Deleting a Page Overlay
You can delete page overlays that you no longer use. 
1 In the printer properties window, click the Extras tab. 

2 Click the Edit button in the Overlay section. 

3 Select the overlay you want to delete from the Overlay List 
box. 

4 Click Delete Overlay. 

5 When a confirming message window appears, click Yes.

6 Click OK until you exit the Print window.
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4 Using Windows PostScript 
Driver
If you want to use the PostScript driver provided with the supplied 
CD-ROM to print a document.
PPDs, in combination with the PostScript driver, access printer 
features and allow the computer to communicate with the printer. An 
installation program for the PPDs is provided on the supplied CD-
ROM. 

Printer Settings
You can use the printer properties window, which allows you to access 
all of the printer options you need when using your printer. When the 
printer properties are displayed, you can review and change the settings 
needed for your print job. 

Your printer properties window may differ, depending on your operating 
system. This Software User’s Guide shows the Properties window for 
Windows XP.

Your printer driver Properties window that appears in this User’s Guide 
may differ depending on the printer in use.

NOTES:
• Most Windows applications will override settings you specify in 

the printer driver. Change all print settings available in the 
software application first, and change any remaining settings 
using the printer driver. 

• The settings you change remain in effect only while you are using 
the current program. To make your changes permanent, make 
them in the Printers folder. 

• The following procedure is for Windows XP. For other Windows 
OS, refer to the corresponding Windows User's Guide or online 
help.
1.Click the Windows Start button.
2.Select Printers and Faxes.
3.Select your printer driver icon.
4.Right-click on the printer driver icon and select 

Printing Preferences.
5.Change the settings on each tab, click OK.

Advanced
You can use advanced settings by clicking the Advanced button. 

• Paper/Output this option allows you to select the size of the 
paper loaded in the tray.

• Graphic this option allows you to adjust the print quality for your 
specific printing needs.

• Document Options this options allow you to set the PostScript 
options or printer features.

Using Help
You can click  from the upper right corner of the window, and then 
click on any setting. 
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5 Sharing the Printer Locally
You can connect the printer directly to a selected computer, which is 
called “host computer,” on the network. 

The following procedure is for Windows XP. For other Windows OS, refer 
to the corresponding Windows User's Guide or online help.

NOTES: 
• Check the Operating System(s) that are compatible with your 

printer. Please refer to the OS Compatibility section of Printer 
Specifications in your Printer User Guide.

• If you need to know the exact name of your printer, you can check 
the supplied CD-ROM.

Setting Up a Host Computer
1 Start Windows. 

2 From the Start menu select Printers and Faxes. 

3 Double-click your printer driver icon. 

4 From the Printer menu, select Sharing. 

5 Check the Share this printer box.

6 Fill in the Shared Name field, and then click OK.

Setting Up a Client Computer 
1 Right-click the Windows Start button and select Explore.

2 Select My Network Places  and then right-click Search for 
Computers.

3 Fill in the IP address of host computer in Computer name field, 
and click Search. (In case host computer requires User name 
and Password, fill in User ID and password of host computer 
account.)

4 Double-click Printers and Faxes.

5 Right-click printer driver icon, select Connect.

6 Click Yes, if the installation confirm message appears.
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6 Using Utility Applications
If an error occurs while printing, the Status Monitor window appears, 
showing the error. 

NOTES:
• To use this program, you need:

- To check for Operating System(s) that are compatible with your 
printer, refer to Printer Specifications in your Printer User 
Guide.

- MAC OS X 10.3 or higher
- Internet Explorer version 5.0 or higher for flash animation in 

HTML Help.
• If you need to know the exact name of your printer, you can check 

the supplied CD-ROM.

Using Printer Settings Utility
Using the Printer Settings Utility, you can configure and check print 
settings. 

1 For Windows, from the Start menu, select Programs or All 
Programs  → SP 3300 Series → Printer Settings Utility.

For MAC OS X, open the Applications folder → RNP → 
SP 3300 Series → Printer Settings Utility.

2 Change the settings. 

3 To send the changes to the printer, click the Apply button.

NOTE: If you connect your printer to a network, the Web Image 
Monitor SP 3300 Series window appears instead of the Printer 
Settings Utility window.

Using Onscreen Help
For more information about Printer Settings Utility, click . 

Opening the Troubleshooting Guide
Using the troubleshooting guide, you can view solutions for error status 
problems.

Double click the Status Monitor icon on the Windows task bar.

Or, from the Start menu, select Programs or All Programs  → 
SP 3300 Series → Troubleshooting Guide.

Changing the Status Monitor Program 
Settings
Select the Status Monitor icon on the Windows task bar and right-click 
the Status Monitor icon. Select Options.

The following window opens.

• Display when job is finished for network printer shows the 
Status Monitor balloon when your job is complete. 

• Display when error occurs during printing shows the Status 
Monitor balloon when an error occurs during printing.

• Schedule an automatic status checking every allows the 
computer to update the printer status regularly. Setting the value 
close to 1 second causes the computer to check the printer status 
more frequently, thereby allowing a faster response to any printer 
error.

Double click this icon.
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7 Using Your Printer with a 
Macintosh
Your machine supports Macintosh systems with a built-in USB 
interface or a 10/100 Base-TX network interface card. When you 
print a file from a Macintosh computer, you can use the PostScript 
driver by installing the PPD file.
This chapter includes:

• Installing Software

• Setting Up the Printer

• Printing

Installing Software
The supplied CD-ROM that came with your machine provides you with 
the PPD file to use the PS driver, Apple LaserWriter driver, for printing on 
a Macintosh computer.

Printer driver

Installing the printer driver

1 Connect your machine to the computer using the USB cable or 
the Ethernet cable. 

2 Turn on your computer and the machine.

3 Insert the supplied CD-ROM which came with your machine 
into the CD-ROM drive.

4 Double-click the SP 3300 Series on your Macintosh desktop. 

5 Double-click the MAC_Installer folder.

6 Double-click the MAC_Printer folder.

7 For Mac OS 8.6~9.2, double-click the SP 3300 Series Installer 
Classic icon.
For Mac OS 10.1 or higher, double-click the SP 3300 Series 
Installer OSX icon.

8 Click Continue.

9 Click Install.

10 After the installation is finished, click Quit.

Uninstalling the printer driver

1 Insert the supplied CD-ROM which came with your machine 
into the CD-ROM drive.

2 Double-click the SP 3300 Series on your Macintosh desktop.

3 Double-click the MAC_Installer folder.

4 Double-click the MAC_Printer folder.

5 For Mac OS 8.6~9.2, double-click the SP 3300 Series Installer 
Classic icon.
For Mac OS 10.1 or higher, double-click the SP 3300 Series 
Installer OSX icon.

6 Select Uninstall and then click Uninstall.

7 Click Continue.

8 When the uninstallation is done, click Quit.
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Setting Up the Printer 
Set up for your printer will be different depending on which cable you use 
to connect the printer to your computer—the network cable or the USB 
cable.

For a Network-connected

Mac OS 8.6 ~ 9.2

1 Follow the instructions on “Installing Software” on page 25 to 
install the PPD file on your computer.

2 From the Apple menu, select Chooser.

3 Click LaserWriter 8 (the PostScript driver provided with your 
Macintosh). 
The name of your machine appears on the list. 

4 Select RFG000xxxxxxxxx from the printer box (where the 
xxxxxxxxx varies depending on each of the machines) and Click 
Select.
If Auto Setup does not work properly, click Select PPD, choose 
your printer name, and click OK.

5 When the setup is complete, you see your machine icon 
created as a desktop printer.

6 Close the Chooser.

7 When a message window appears telling you that you have 
changed your current machine, click OK.

Mac OS 10.1 or higher

1 Follow the instructions on “Installing Software” on page 25 to 
install the PPD file on your computer.

2 Open the Applications folder → Utilities, and Print Setup 
Utility.
• For MAC OS 10.5, open System Preferences from the 

Applications folder, and click Printer & Fax.

3 Click Add on the Printer List.
• For MAC OS 10.5, press the “+” icon then a display window 

will pop up. 

4 For MAC OS 10.3, select the Rendezvous tab. 
• For MAC OS 10.4, click Default Browser and find the 

Bonjour.
• For MAC OS 10.5, click Default and find the Bonjour.
The name of your machine appears on the list. Select 
RFG000xxxxxxxxx from the printer box, where the xxxxxxxxx 
varies depending on your machine.

5 For MAC OS 10.3, if Auto Select does not work properly, select 
SP 3300 Series in Printer Model and your printer name in 
Model Name. 

• For MAC OS 10.4, if Auto Select does not work properly, 
select SP 3300 Series in Print Using and your printer 
name in Model. 

• For MAC OS 10.5, if Auto Select does not work properly, 
select Select a driver to use... and your printer name in 
Print Using. 

Your machine appears on the Printer List and is set as the 
default printer.

6 Click Add.

For a USB-connected

Mac OS 10.1 or higher

1 Follow the instructions on “Installing Software” on page 25 to 
install the PPD file on your computer.

2 Open the Applications folder → Utilities, and Print Setup 
Utility.
• For MAC OS 10.5, open System Preferences from the 

Applications folder, and click Printer & Fax.

3 Click Add on the Printer List.
• For MAC OS 10.5, press the “+” icon then a display window 

will pop up. 

4 For MAC OS 10.3, select the USB tab. 
• For MAC OS 10.4, click Default Browser and find the USB 

connection.
• For MAC OS 10.5, click Default and find the USB connection.

5 Select your printer name.

6 For MAC OS 10.3, if Auto Select does not work properly, select 
SP 3300 Series in Printer Model and your printer name in 
Model Name. 
• For MAC OS 10.4, if Auto Select does not work properly, 

select SP 3300 Series in Print Using and your printer 
name in Model. 

• For MAC OS 10.5, if Auto Select does not work properly, 
select Select a driver to use... and your printer name in 
Print Using. 

Your machine appears on the Printer List and is set as the 
default printer.

7 Click Add.
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Printing 

NOTES: 
• The Macintosh printer’s properties window that appears in this 

User’s Guide may differ depending on the printer in use. However 
the composition of the printer properties window is similar.

• You can check your printer name in the supplied CD-ROM.

Printing a Document
When you print with a Macintosh, you need to check the printer software 
setting in each application you use. Follow these steps to print from a 
Macintosh.

1 Open a Macintosh application and select the file you want to 
print.

2 Open the File menu and click Page Setup (Document Setup 
in some applications). 

3 Choose your paper size, orientation, scaling, and other options 
and click OK.

4 Open the File menu and click Print.

5 Choose the number of copies you want and indicate which 
pages you want to print. 

6 Click Print when you finish setting the options.

Make sure that your 
printer is selected.

▲ Mac OS 10.3

Changing Printer Settings
You can use advanced printing features when using your printer.

From your Macintosh application, select Print from the File menu. 

NOTE: The setting options may differ depending on Macintosh OS 
version.

Layout

The Layout tab provides options to adjust how the document appears 
on the printed page. You can print multiple pages on one sheet of paper. 
Select Layout from the Presets drop-down list to access the following 
features.

• Pages per Sheet: This feature determines how many pages 
printed on one page. For details, see "Printing Multiple Pages 
on One Sheet of Paper (N-Up Printing)" on the next column.

• Layout Direction: You can select the printing direction on a 
page as like the examples on UI.

▲ Mac OS 10.4
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Printer Features

This tab provides options for selecting the paper type and adjusting print 
quality. Select Printer Features from the Presets' drop-down list to 
access the following features:

• Reverse Duplex Printing: Allows you to select general print 
order compare to duplex print order.

• Fit to Page: This setting allows you to scale your print job to 
any selected paper size regardless of the digital document 
size. This can be useful when you want to check fine details 
on a small document.

• Toner Save Mode: Selecting this option extends the life of 
your toner cartridge and reduces your cost per page without a 
significant reduction in print quality. 

• Image Mode: Image Mode allows the user to enhance 
printouts. The available options are Normal and Text 
Enhance. 

• Paper Type: Set Paper Type to correspond to the paper 
loaded in the tray from which you want to print. This will let 
you get the best quality printout. If you load a different type of 
print material, select the corresponding paper type.

• Resolution: You can select the printing resolution. The 
higher the setting, the sharper the clarity of printed characters 
and graphics. The higher setting also may increase the time it 
takes to print a document.

▲ Mac OS 10.4

Printing Multiple Pages on One Sheet of 
Paper (N-Up Printing)
You can print more than one page on a single sheet of paper. This 
feature provides a cost-effective way to print draft pages.

1 From your Macintosh application, select Print from the File 
menu. 

2 Select Layout.

3 Select the number of pages you want to print on one sheet of 
paper on the Pages per Sheet drop-down list.

4 Select the page order from the Layout Direction option.
To print a border around each page on the sheet, select the 
option you want from the Border drop-down list.

5 Click Print, and the printer prints the selected number of pages 
on one side of each page.

▲ Mac OS 10.4

Download from Www.Somanuals.com. All Manuals Search And Download.



Using Your Printer with a Macintosh
29

Duplex Printing
You can print on both sides of the paper. Before printing in the duplex 
mode, decide on which edge you will be binding your finished document. 
The binding options are:

Long-edge binding: Which is the conventional layout used in book 
binding.

Short-edge binding: Which is the type often used with calendars. 

1 From your Macintosh application, select Print from the File 
menu. 

2 Select the Layout. 

3 Select a binding orientation from Two-Sided option.

4 Click Print and the printer prints on both sides of the paper. 

NOTE: If you have selected duplex printing and then try to print 
multiple copies of a document, the printer may not print the 
document in the way you want. In case of  "Collated copy", if your 
document has odd pages, the last page of the first copy and the first 
page of the next copy will be printed on the front and back of one 
sheet. In case of  "Uncollated copy", the same page will be printed 
on the front and back of one sheet. Therefore, if you need multiple 
copies of a document and you want those copies on both sides of 
the paper, you must print them one at a time, as separate print jobs.

▲ Mac OS 10.3
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Software section 
Index

A
advanced printing, use 17

B
booklet printing 18

D
document, print

Macintosh 27
Windows 11
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E
Extras properties, set 15

F
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G
Graphics properties, set 14

H
help, use 16, 22

I
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install
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Windows 3

L
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Windows 13
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uninstall
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OpenSSL License
Copyright (c) 1998-2001 The OpenSSL Project. All rights 
reserved.

Redistribution and use in source and binary forms, with or without 
modification, are permitted provided that the following conditions are 
met:
1. Redistributions of source code must retain the above copyright 

notice, this list of conditions and the following disclaimer. 
2. Redistributions in binary form must reproduce the above copyright 

notice, this list of conditions and the following disclaimer in the 
documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software 
must display the following acknowledgment: "This product includes 
software developed by the OpenSSL Project for use in the 
OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be 
used to endorse or promote products derived from this software 
without prior written permission. For written permission, please 
contact openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL" 
nor may "OpenSSL" appear in their names without prior written 
permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following 
acknowledgment: "This product includes software developed by the 
OpenSSL Project for use in the OpenSSL Toolkit (http://
www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS 
IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT 
OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED 
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, 
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE.

This product includes cryptographic software written by Eric 
Young(eay@cryptsoft.com). This product includes software written by 
Tim Hudson (tjh@cryptsoft.com).

Original SSLeay License
Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com) All 
rights reserved.

This package is an SSL implementation written by Eric Young 
(eay@cryptsoft.com). The implementation was written so as to conform 
with Netscapes SSL.

This library is free for commercial and non-commercial use as long as 
the following conditions are aheared to. The following conditions apply to 
all code found in this distribution, be it the RC4, RSA, lhash, DES, etc., 

code; not just the SSL code. The SSL documentation included with this 
distribution is covered by the same copyright terms except that the 
holder is Tim Hudson (tjh@cryptsoft.com). Copyright remains Eric 
Young's, and as such any Copyright notices in the code are not to be 
removed. If this package is used in a product, Eric Young should be given 
attribution as the author of the parts of the library used. This can be in 
the form of a textual message at program startup or in documentation 
(online or textual) provided with the package.

Redistribution and use in source and binary forms, with or without 
modification, are permitted provided that the following conditions are 
met:
1. Redistributions of source code must retain the copyright notice, this 

list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright 

notice, this list of conditions and the following disclaimer in the 
documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software 
must display the following acknowledgement: "This product includes 
cryptographic software written by Eric Young (eay@cryptsoft.com)" 
The word 'cryptographic' can be left out if the rouines from the 
library being used are not cryptographic related:-). 

4. If you include any Windows specific code (or a derivative thereof) 
from the apps directory (application code) you must include an 
acknowledgement: "This product includes software written by Tim 
Hudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY 
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN 
NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE 
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, 
OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED 
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY 
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

The licence and distribution terms for any publically available version or 
derivative of this code cannot be changed. i.e. this code cannot simply 
be copied and put under another distribution licence [including the GNU 
Public Licence.]
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Contents of this manual are subject to change without prior notice. In no event will the company be liable for direct, indirect, incidental or consequential damages as a result of 
handling or operating the machine.

Copyright© 2008

• Microsoft, Windows, Windows 2000, Windows XP, Windows Vista, and Windows Server 2003 are registered trademarks of Microsoft Corporation.
• Macintosh, AppleTalk, and EtherTalk are registered trademarks of Apple Computer, Inc.
• All other brand or product names are trademarks of their respective companies or organizations.
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1 Getting started

Introduction
The Network Printer Card allows you to connect your printer directly to a 
network to share the printer among multiple users. The printer functions 
as a network print server supporting various network environments, such 
as Windows 2000/XP/Vista, Windows Server 2003, and Macintosh 8.6 
or higher. 

This guide explains how to connect the Network Printer Card and set up 
your printer as a print sever over the network. 

This guide assumes that you have:

• A good working knowledge of your network utilities

• A supported network operating system

• A fully operational computer system

• Access to the supervisor account as a network administrator, or 
access to an account that has supervisor and print server operator 
privileges

Supported network environments
Administrators and users can configure, and use printers on the 
following supported network operating systems:

Note: Your printer may not support all of the listed computing 
environments (operating systems). Therefore, check the network 
environment your printer supports in the user's guide that came with the 
printer.

Operating 
system

Network 
environment

Printing 
protocol Action

Windows 2000, XP, Vista, 
Server 2003

TCP/IP, 
EtherTalk, 
SNMP, 
HTTP 1.1

See Chapter 3, 
“Print Driver 
Installation for 
Networked 
Printers.”

Macintosh Macintosh 8.6 ~ 
9.2, 10.1 ~ 10.5, 
or higher

TCP/IP, 
EtherTalk, 
SNMP, 
HTTP 1.1, 
Bonjour

See Chapter 5, 
“EtherTalk 
environment.”

Network Printer Card

System requirements
The following hardware is required to configure your printer for network 
applications.

Connecting your Network Printer Card
1 Use a twisted pair cable with an RJ-45 connector to connect the 

printer to your network. 

Once a connection is established between the wired network 
printer card and your network, the link LEDs on the card light.

2 Set up your printer's IP address. See “IP address setup” on 
page 2.2. 

Computer Requirements

IBM - 
compatible PC

• 80486 CPU or higher
• Minimum of 16 MB of RAM
• 2 MB of free disk space

Macintosh • PowerPC 68020 or higher 
• Minimum of 8 MB of RAM
• 2 MB of free disk space

Link LED: Lights when the printer card is
connected to the network.

Activity LED: Blinks when data packets
are being transferred.
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2 Programs supplied on the 
CD
The CD-ROM supplied with your printer card provides you with:

• Set IP: A utility program allowing you to select a network printer card 
and manually configure the addresses for use with the TCP/IP 
protocol.

System requirements
To install SetIP, one of the following operating systems is required:

• Operating system: Windows 2000/XP/Vista/Windows Server 2003, 
MAC OS 10.3~10.5

Installing software
1 Insert the supplied CD-ROM into your CD-ROM drive.

The CD-ROM should automatically run, and an installation window 
appears. 

If the installation window does not appear, click Start > Run. Type 
X:\Setup.exe, replacing “X” with the letter which represents your 
drive and click OK.

If you use Windows Vista, click Start > All Programs > 
Accessories > Run, and type X:\Setup.exe.

If the AutoPlay window appears in Windows Vista, click Run 
Setup.exe in Install or run program field, and click Continue in 
the User Account Control window.

2 Click Next.

3 Select the language you want.

4 Click Typical installation for a network printer.

5 Follow the onscreen instructions to complete installation.

6 Click Finish when installation is done.

Uninstalling software
You should remove the Network utilities if you are upgrading the software 
or if the installation fails.

Note: Close all programs before uninstalling software.

1 Click Start > Programs > SP 3300 Series > Set IP > Set IP.

2 Click OK to confirm uninstallation.

3 Click Finish when uninstallation is done.
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IP address setup
Before using your network print server in your network, you must set 
TCP/IP addresses for the print server. You will need your printer card’s 
MAC address, IP address, subnet mask, and gateway address. First, 
check with your network administrator for the TCP/IP addresses.

Note: The MAC address is the hardware serial number of the network 
printer card. You can check the address by printing the Network Printer 
Configuration Page. For printing the page, refer to your printer user’s 
guide.

You can set your print server’s IP address via the following methods:

• Set IP program: Go to the Using SetIP.

• Web Image Monitor SP 3300 Series: Once you have set an IP 
address for your network print server, you can use the embedded 
web server in the network printer card to change the address. Go to 
next column.

• DHCP: You can use Dynamic Host Configuration Protocol (DHCP) to 
get an IP address automatically assigned by your network 
administrator, if your network system supports this protocol.s

• BOOTP: A network-based server using the BootStrap protocol 
(BOOTP) can notify the network printer card of its assigned IP 
address each time the printer turns on, if your network system 
supports this protocol.

Note: To get an IP address from the DHCP or BOOTP server, the IP 
assignment method must be set to DHCP or BOOTP.

Using SetIP

Windows

1 From the Start menu, select Programs or All Programs > SP 
3300 Series > Set IP.

The program automatically detects and displays new and 
configured print servers on your network.

2 Select the name of your printer and click . If you cannot find 
your printer name, click  to refresh the list.

Even with this step, if you cannot find your printer name, then 
contact Network Administrator.

3 Enter your network printer card’s MAC address (hardware 
address), IP address, subnet mask, default gateway, and then click 
Apply.

4 Click OK to confirm the settings.

5 Click Exit to close the SetIP program.

MAC OS X

If you want to change your network printer IP setting, follow the below 
instruction.

1 Printer the machine’s network information report which includes 
your machine’s MAC address.

2 Open the Library folder > Printers > RFG > your printer model 
name > Set IP.

3 Double click the SetIPApplet.html file.

Using Web Image Monitor SP 3300 Series

1 Run your web browser.

2 Enter your print server’s IP address in the URL field and click Go.

3 Click Network Settings > TCP/IP.

4 Select Static from IP Address Assignment Method.

5 Enter your print server’s TCP/IP addresses and click Apply.
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3 Print Driver Installation for 
Networked Printers
This chapter explains how to install the print drivers for networked 
printers.

Workstation Setup
This section includes the setup procedures for the various Windows 
workstation environments. 

Windows Vista (TCP/IP)

Note: Windows Vista supports printing via TCP/IP as standard when 
TCP/IP is installed on a Windows Vista Workstation.

Use the AutoPlay to add the printer to the network.

1 Select Start, select Control Panel > Hardware and Sound > 
Printers.

Double-click on the Add a printer icon to display the Add Printer 
Wizard.

2 Select Add a printer, uncheck the box labelled Automatically 
detect and install my Plug and Play printer.and then select Next 
to display the dialog box listing available ports.

3 Select Create a new port to display the Printer Ports dialog box.

Select Standard TCP/IP Port and select Next to display the Add 
Standard TCP/IP Port dialog box.

Enter the IP Address of the printer in the Printer Name or IP 
Address field (you can optionally enter a friendly name for the 
printer port you are creating or use the default name created). Then 
select Next to continue.If the network printer settings are not 
automatically detected, click on the Custom button to setup the 
network printer port settings.

It is recommended that you select Raw as the Print Protocol.

If you prefer to use LPR:

Select LPR as the Print Protocol.

Enter lp (in lower case) in the Queue Name field. 

Uncheck the box labelled LPR Byte Counting Enabled.

Check the box labelled SNMP Status Enabled.

The Community Name should normally be set to “public” (unless 
you have configured the device to have a custom SNMP 
community name) and the SNMP Device Index should be set to 
1.

Select OK.

4 The Add Printer Wizard will then request that you select the driver 
to be used for this printer.

Insert the supplied CD-ROM into the workstation and select Have 
Disk.

Browse to the required Windows Vista driver on the CD-ROM and 
select OK.

Note: The driver will be found in the Printer folder on the CD in the 
appropriate PCL folder. The driver is identified by the file extension .inf. 

Select Next, and select Next again and the printer driver will be 
loaded onto the workstation.

Enter the Printer Name and select Next.

5 If you wish to share the printer over the network Select Share 
name. You may also wish to install printer drivers for other 
operating systems that will access the printer.

A dialog box will be displayed with a message regarding the 
printing of a test page.

Select Finish to accept the Yes choice.

6 Continue with Test Print.

Windows XP (TCP/IP)

Note: Windows XP supports printing via TCP/IP as standard when 
TCP/IP is installed on a Windows XP Workstation.

Use the Add Printer Wizard to add the printer to the network.

1 Select Start, select Printers and Faxes.

Double-click on the Add a printer icon to display the Add Printer 
Wizard.

2 Select Add a printer, uncheck the box labelled Automatically 
detect and install my Plug and Play printer.and then select Next 
to display the dialog box listing available ports.

3 Select Create a new port to display the Printer Ports dialog box.

Select Standard TCP/IP Port and select Next to display the Add 
Standard TCP/IP Port dialog box.

Enter the IP Address of the printer in the Printer Name or IP 
Address field (you can optionally enter a friendly name for the 
printer port you are creating or use the default name created). Then 
select Next to continue.If the network printer settings are not 
automatically detected, click on the Custom button to setup the 
network printer port settings.

It is recommended that you select Raw as the Print Protocol.

If you prefer to use LPR:

Select LPR as the Print Protocol.
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Enter lp (in lower case) in the Queue Name field. 

Uncheck the box labelled LPR Byte Counting Enabled.

Check the box labelled SNMP Status Enabled.

The Community Name should normally be set to “public” (unless 
you have configured the device to have a custom SNMP 
community name) and the SNMP Device Index should be set to 
1.

Select OK.

4 The Add Printer Wizard will then request that you select the driver 
to be used for this printer.

Insert the supplied CD-ROM into the workstation and select Have 
Disk.

Browse to the required Windows XP driver on the CD-ROM and 
select OK.

Note: The driver will be found in the Printer folder on the CD in the 
appropriate PCL folder. The driver is identified by the file extension .inf. 

Select Next, and select Next again and the printer driver will be 
loaded onto the workstation.

Enter the Printer Name and select Next.

5 If you wish to share the printer over the network Select Share 
name. You may also wish to install printer drivers for other 
operating systems that will access the printer.

A dialog box will be displayed with a message regarding the 
printing of a test page.

Select Finish to accept the Yes choice.

6 Continue with Test Print.

Windows 2000 (TCP/IP)

Note: Windows 2000 supports printing via TCP/IP as standard when 
TCP/IP is installed on a Windows 2000 Workstation.

Use the Add Printer Wizard to add the printer to the network.

1 Select Start, select Settings, and then select Printers.

Double-click on the Add printer icon to display the Add Printer 
Wizard.

2 Select Local printer, uncheck the box labelled Automatically 
detect and install my Plug and Play printer.and then select 
[Next] to display the dialog box listing available ports.

3 Select Create a new port to display the Printer Ports dialog box.

Select Standard TCP/IP Port and select Next to display the Add 
Standard TCP/IP Port dialog box.

Enter the IP Address of the printer in the Printer Name or IP 
Address field (you can optionally enter a friendly name for the 
printer port you are creating or use the default name created). Then 
select Next to continue.

If the network printer settings are not automatically detected, click 
on the Custom button to setup the network printer port settings.

It is recommended that you select Raw as the Print Protocol.If you 
prefer to use LPR:

Select LPR as the Print Protocol.

Enter lp (in lower case) in the Queue Name field. 

Uncheck the box labelled LPR Byte Counting Enabled.

Check the box labelled SNMP Status Enabled.

The Community Name should normally be set to “public” (unless 
you have configured the device to have a custom SNMP 
community name) and the SNMP Device Index should be set to 
1.

Select OK.

4 The Add Printer Wizard will then request that you select the driver 
to be used for this printer.

Insert the supplied CD-ROM into the workstation and select Have 
Disk.

Browse to the required Windows 2000 driver on the CD-ROM and 
select OK.

Note: The driver will be found in the Printer folder on the CD in the 
appropriate PCL folder. The driver is identified by the file extension .inf. 

Select Next, and select Next again and the printer driver will be 
loaded onto the workstation.

Enter the Printer Name and select Next.

5 If you wish to share the printer over the network Select Share 
name. You may also wish to install printer drivers for other 
operating systems that will access the printer.

6 If you wish to share the printer over the network Select Share as. 
You may also wish to install printer drivers for other operating 
systems that will access the printer.

A dialog box will be displayed with a message regarding the 
printing of a test page.

Select Finish to accept the Yes choice.

7 Continue with Test Print.
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Test Print
To ensure the printer has been installed on the network correctly a test 
print should be submitted from a client workstation. Perform the following 
steps:

1 Open a document on a client workstation.

2 Select the SP 3300 Series as the printer for sending documents to.

3 Print the document on the device and verify that it prints correctly.

4 Ensure the print driver is installed on every workstation that will be 
sending jobs to the device.

5 Repeat the test for all workstations that will be sending jobs to the 
device.
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4 TCP/IP environment
A TCP/IP network provides you with various protocols for using printing 
devices and managing various types of networked devices.

In this chapter, you will learn which management protocols are available 
in TCP/IP network environments, and how to print via your network print 
server using TCP/IP protocol.

Management protocols
Before beginning to print documents via your network printer, you need 
to check or configure some parameters using management protocols.

DHCP/BOOTP
Dynamic Host Configuration Protocol (DHCP) is a communication 
protocol enabling network administrators to centrally manage and to 
automate the assignment of IP addresses in a network. In an IP network, 
each device needs a unique IP address. DHCP lets a network 
administrator supervise and distribute IP addresses from a central point 
and automatically sends a new IP address when a device is plugged into 
a different place in the network. 

Bootstrap Protocol (BOOTP) is UDP/IP-based protocol which allows a 
booting host to configure itself dynamically and without user supervision. 
BOOTP provides means to notify a host of its assigned IP address, the 
IP address of a boot server host, and other configuration information, 
such as the local subnet mask, the local time offset, and the addresses 
of default routers. Addresses of various Internet servers can also be 
transferred to a host using BOOTP. 

DHCP is active by factory default on your network print server. After boot 
up, the network print server will get an IP address automatically from the 
DHCP server, if one exists. To set an IP address manually, see page 2.2.

Configuring DHCP/BOOTP

To enable or disable DHCP/BOOTP, use one of the following methods:

• Web Image Monitor SP 3300 Series: Select Network Settings > 
TCP/IP and select DHCP or BOOTP from the IP Address Assignment 
Method list.

HTTP
Hypertext Transfer Protocol (HTTP) is an application layer protocol for 
distributed, collaborative, hypermedia information systems. It is a 
generic, stateless protocol which can be used for many tasks beyond its 
use for hypertext, such as with name servers and distributed object 
management systems. You are using HTTP when you connect your 
network printer via a web browser.

The Network Printer Card has a built-in web server, Web Image Monitor 
SP 3300 Series. You can configure and manage your network print 
server through Web Image Monitor SP 3300 Series using HTTP over 
TCP/IP.

SNMP
Simple Network Management Protocol (SNMP), which is part of the 
TCP/IP protocol suite, is an application layer protocol that facilitates the 
exchange of management information between network devices. It 
enables network administrators to remotely monitor and configure 
network devices, find and solve network problems, and plan for network 
growth.

Network devices are monitored and controlled using four basic SNMP 
commands: 

• read: is used by a Network Management server to monitor network 
devices. The server examines different variables that are maintained 
by the devices.

• write: is used by a Network Management server to control managed 
devices. The server changes the values of variables stored within the 
devices.

• trap: is used by network devices to asynchronously report events to a 
Network Management server. When certain types of events occur, a 
device sends a trap to the specified server.

• Traversal operations: are used by a Network Management server to 
determine which variables a network device supports and to 
sequentially gather information in variable tables, such as a routing 
table.

Configuring SNMP

To access your network print server using SNMP, Community Name/
Access Permission pair must be properly specified. There are two 
access permission: read and write.

Assign the IP addresses of trap hosts and community names (IP 
addresses) of network devices in Web Image Monitor SP 3300 Series; 
select Network Settings > SNMP. 

Using SNMP

Web Image Monitor SP 3300 Series accesses, configures, and manages 
network devices using SNMP. You can use other MIB (Management 
Information Base) browser software, which allows you to access 
management information gathered from network devices.
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SLP
Service Location Protocol (SLP) is an Internet standard network protocol 
that provides a framework to allow networking applications to discover 
the existence, location, and configuration of networked services in 
enterprise networks, such as printers, Web servers, fax machines, video 
cameras, file systems, backup devices (tape drives), databases, 
directories, mail servers, and calendars. 

In order to locate services on the network, users of network applications 
are required to supply the host name or network address of the device 
that supplies a desired service. However, SLP eliminates the need for a 
user to know the name of a network host supporting a service. Rather, 
the user only needs to supply the desired type of service and set of 
attributes or keywords, which describe the service. 

Based on that description, SLP also resolves the network address of the 
service of the user. Administrators do not need to help clients find new 
services or to remove services when they are no longer available. SLP 
uses multicasting and can work over subnet boundaries.

Configuring SLP

You can configure SLP protocol settings through Web Image Monitor SP 
3300 Series. Select Network Settings > SLP.

• SLP Protocol: You can enable or disable SLP. 

• Port Number: The port number is fixed to 427.

• Scope 1 ~ 3: A scope is a set of services and a string used to group 
resources by location, network, or administrative category. Each 
scope should not be more than 32 characters. 

• Message Type: You can select the outgoing SLP message type sent 
to network devices. The default value is Multicast.

• Multicast Radius: You can specify the maximum number of subnets 
that SLP multicasts can travel across. This value is also called the 
“hop count” or “time-to-live” (TTL). The default value is 255. 

• Registration Lifetime: You can define the time in seconds before the 
Server Agents registration expires.

• Multicast Address: The Multicast Address value is fixed to 
239.255.255.253, 224.0.1.127.

Using SLP

Once Enabled is checked, the network print server works as a Service 
Agent and the User Agent.

Dynamic DNS (DDNS)
DNS (Domain Name System) is used for registration of domain names 
and provides Host names to an IP address resolution service. For printer 
devices, DNS may be utilised for printer domain name registration, so 
that print server clients may refer to the printer by its host name rather 
than by its IP address. Even though a printer’s IP address is changed, all 
clients can operate this printer without reconfiguration. Addressing to a 
printer device by IP address is not convenient and may often go stale if 
an IP address to a device is assigned dynamically via a DHCP server. If 

the DHCP server can provide information about a printer’s changing IP 
address to the DNS server automatically, user convenience is increased. 
The printer’s name will be used as its DNS name.

Configuring DDNS

1 Let the DHCP server provide updated information to the DNS 
server.

2 Configure the same DDNS domain through Web Image Monitor SP 
3300 Series as entered in the DNS server.

If you connect your network printer via a web browser, you can 
enable this by selecting Network Settings > TCP/IP > Dynamic 
DNS Registration.

3 Set the IP assignment method of your network print server to 
DHCP and reboot the printer.

The DNS server will update its database and users can use the 
printer’s name instead of its IP address.

WINS
Before Dynamic DNS was defined, DNS could only be updated manually 
when DHCP servers automatically provided (or removed) IP addresses. 
As a result, DNS servers often contained obsolete listings. In response, 
Microsoft developed Windows Internet Name Service (WINS) to solve 
this problem for NetBIOS names. 

Microsoft now recommends moving to Dynamic DNS and away from 
WINS. However, many customers including Microsoft maintain WINS 
systems and need devices to interoperate with WINS. So devices must, 
at least for now, support WINS interoperability to allow for dynamic 
NetBIOS name to IP address registration and resolution. 

WINS provides a distributed database for registering and querying 
dynamic NetBIOS names to IP address mapping in a routed network 
environment. This is the best choice for NetBIOS name resolution in 
such a routed network because it is designed to solve the problems that 
occur with name resolution in complex Internet networks.

Configuring WINS

Access Web Image Monitor SP 3300 Series and select Network 
Settings > TCP/IP. You will configure two WINS server addresses, the 
Primary WINS Server or the Secondary WINS Server. The default value 
is 0.0.0.0.

In a DHCP server

A DHCP server can support the NBNS (NetBIOS Name Server) option. 
An administrator has to set the WINS server IP address in the NBNS 
option.

1 Set the IP assignment method of your network print server to 
DHCP.

2 Reboot the print server.

The WINS server will update the printer's NetBIOS name in its 
database. Users can use the printer name instead of its IP address.
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In the network print server

1 Configure the WINS server address through Web Image Monitor 
SP 3300 Series.

2 Reboot the print server.

The WINS server will update the printer's NetBIOS name in its 
database. Users can use the printer name instead of its IP address.

Bonjour
Bonjour allows for a network system to be easily discovered and its 
capabilities to be revealed by any Bonjour-compliant client software, 
such as Print Center Utility built in to Mac OS X. For details, see 
page 5.2.

UPnP
UPnP is an architecture for pervasive peer-to-peer network connectivity 
of intelligent appliances, wireless devices, and PCs of all form factors. It 
is designed to bring easy-to-use, flexible, standards-based connectivity 
to ad-hoc or unmanaged networks whether in the home, in a small 
business, public spaces, or attached to the Internet. 

UPnP is a distributed, open networking architecture that leverages TCP/
IP and Web technologies to enable seamless proximity networking in 
addition to control and data transfer among networked devices in the 
home, office, and public spaces.

UPnP is more than just a simple extension of the plug and play 
peripheral model. It is designed to support zero-configuration, “invisible” 
networking, and automatic discovery for a wide breadth of device 
categories from a wide range of vendors. This means a device can 
dynamically join a network, obtain an IP address, convey its capabilities, 
and learn about the presence and capabilities of other devices. DHCP 
and DNS servers are optional and are used only if available on the 
network, while a device can leave a network smoothly and automatically 
without leaving any unwanted state issues behind.

UPnP supports 6 protocol stacks for addressing, discovery, description, 
control, eventing, and presentation, but the Network Printer Card 
supports only Simple Service Discovery Protocol (SSDP) which allows 
addressing, description, and discovery.

Configuring UPnP

• Web Image Monitor SP 3300 Series: Select Network Settings > 
UPnP.
- Auto IP Enabled: You can enable or disable Auto IP. When this 

option is selected, the network print server cannot find the control 
point and receive an IP address from the control point. The network 
print server will create an IP address of “169.254.XXX.XXX.”

- Multicast DNS Enabled: SSDP can use Multicast DNS.
- SSDP Enabled: You can enable or disable SSDP.
- SSDP TTL: You can specify the maximum number of subnets that 

SSPD multicasts can travel across.

Using UPnP

If SSDP (Simple Service Discovery Protocol) is enabled, your network 
print server is checked by a control point. This control point is an 
application which supports finding UPnP devices. Information on 
searching and control functions or your network print server’s device 
information is displayed in an XML page (http://xxx.xxx.xxx.xxx:5200/
printer.xml).
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Printing protocols
Before setting the network printing ports, you must install the printer 
driver with the local port (LPT) on the system. Refer to your printer user’s 
guide.

Standard TCP/IP port
You can print your documents to your network printer by creating a 
Standard TCP/IP port. 

Configuring Standard TCP/IP in Windows 2000/XP/Vista/
Windows Server 2003

You can enable or disable the Standard TCP/IP Printing port through 
Web Image Monitor SP 3300 Series. Select Network Settings > Raw 
TCP/IP,LPR,IPP. 

You can also change the port number of the Standard TCP/IP port. The 
default port number is 9100.

Creating a Standard TCP/IP port

1 In Windows XP, click Start > Printers and Faxes. 

In Windows 2000/Windows Server 2003, click Start > Settings > 
Printers. 

In Windows Vista, click Control Panel > Hardware and Sound > 
Printers.

2 Click Add a printer or double-click Add printer, and then Next.

3 Click Local printer attached to this computer and then Next.

Make sure that Automatically detect and install my Plug and 
Play printer. is not selected.

4 Click Create a new port, select Standard TCP/IP Port from the 
Type of port list, and click Next.

5 Click Next.

6 Enter the IP address or DNS name of your network printer and click 
Next.

For the port name, a default name will be entered by Windows. You 
can change it to a more user-friendly name.

7 Follow the instructions on the screen to complete installation.

Now, you can select your printer from the Print Setup dialogue box.

LPR port
LPD, Line Printer Daemon, is the protocol associated with line-printer 
spooling services. Users can use the printing service from LPD running 
on a network print server through the LPR port. Most operating systems, 
such as Microsoft Windows 2000/XP/Vista/Windows Server 2003, 
support LPR port printing. 

Configuring an LPR port

You can enable or disable the LPR Printing port through Web Image 
Monitor SP 3300 Series. Select Network Settings > Raw TCP/
IP,LPR,IPP. You can also change the port number of LPR/LPD. The 
default port number is 515.

In Windows 2000/XP/Vista/Windows Server 2003

To add an LPR port to Windows 2000/XP/Vista/Windows Server 2003, 
users must install a Standard TCP/IP port by default, then change the 
printing protocol in the printer properties. For installing the Standard 
TCP/IP port, see page 4.4.

1 In Windows XP, click Start > Printers and Faxes. 

In Windows 2000/Windows Server 2003, click Start > Settings > 
Printers. 

In Windows Vista, click Control Panel > Hardware and Sound > 
Printers.

2 Right-click the printer you want and select Properties.

3 Click Ports.

4 Make sure that the appropriate Standard TCP/IP port is selected 
and click Configure Port.

5 Select LPR from the Protocol section.

6 Enter the print queue name and click OK.

7 Click OK to close the properties window.

Printer Port
A Network Printer port is used to send print jobs from network computers 
running Windows OS that do not support the Standard TCP/IP port or 
LPR port. Adding a Network Printer port

1 From the Windows Start menu, select Settings > Printers.

2 Right-click the printer you want and select Properties.

3 Open the Details tab and click Add Port.

4 Select Network Printer Port from the Other list and click OK.

5 Select the print server you want to use and click OK.

If you cannot find the print server, click Add New Print Server to 
list, specify information for the print server, such as print server 
name, IP address, or MAC address, and click OK.
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6 When the port name displays in the Print to the following port list, 
click OK or Close.

IPP port
Internet Printing Protocol (IPP) allows printing across the Internet, 
meaning that you can send a print job to your printer from a remote place 
if you are an Internet user, no matter what operating system you use or 
where you are.

Configuring IPP in the print server

The network administrator must specify information required for IPP, 
such as the URI (Uniform Resource Identifier).

1 Run your web browser and access Web Image Monitor SP 3300 
Series. 

2 Click Network Settings > Raw TCP/IP,LPR,IPP.

3 Configure the IPP parameters:

• Printer Name: Enter the network printer's name to be used with 
IPP printing.

• Printer URI: Enter the URL of the printer using the following 
format: ipp://the IP address of the printer or http://the IP address 
of the printer:631 (Ex:ipp://168.10.17.82 or http://
168.10.17.82:631) 631 is the IPP port number.

• Printer Information: Enter additional information about the 
printer.

• More Printer Information: Enter more additional information 
about the printer.

• Printer Location: Enter the name of the location where the 
printer is physically located.

• Multiple Operation Timeout: Enter the time to elapse before the 
printer ends a print job. When there is no incoming data after the 
specified number of seconds, the printer ends reception.

• Time to Keep Jobs in History: Set the length of time the IPP 
printer keeps job information.

• Operator Message: Enter printer information for printer users.

• Job Count: shows the number of print jobs.

• Driver Installer: shows the URL where you can get the driver 
installer.

• Manufacturer: shows the URL where you can get manufacturer 
information.

4 Click Apply. 

Configuring a Windows client

After the network administrator has configured the network print server, 
each printer user must install the printer driver and set the print port to 
IPP 1.1 Port Monitor.

Note: Before following the steps below, each printer user should install 
the printer driver. If the printer driver is not already installed on the 
computer, install the printer driver that came with the printer. Select the 
local port (LPT) when you install the driver.

1 In Windows XP, click Start > Printers and Faxes. 

In Windows 2000/Windows Server 2003, click Start > Settings > 
Printers. 

In Windows Vista, click Control Panel > Hardware and Sound > 
Printers.

2 Right-click the printer you want and select Properties.

3 In Windows 2000/XP/Vista//Windows Server 2003, click Ports.

4 Click Add Port.

5 Select IPP Port from the Other list and click OK.

6 Enter the printer URL and port name and click OK.

7 When the port name displays on the print port list, click OK. 

Now you can select the network print server from the Print Setup 
dialogue box to send a job.

Setting IPP security

Web Image Monitor SP 3300 Series allows administrators to choose an 
authentication method and to create or modify user accounts.

1 Run your web browser and access Web Image Monitor SP 3300 
Series. 

2 Click Network Settings > Raw TCP/IP,LPR,IPP.

• Authentication Type: You can set a user name and password 
encryption method (refer to http digest authentication in RFC).

• User: You can set a user name and password for IPP printing. 
You can set up the user database for up to 10 items. 

3 Click Apply. 

Note: A user name should be unique for all slots and should not include 
symbols. The length of the user name and the password should each 
be less than 7 characters.
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Additional functions
The following are additional functions you can use through Web Image 
Monitor SP 3300 Series.

Printer properties settings

You can check and modify printer and document properties for an 
installed printer. For properties that are not supported by the printer 
driver, an error message indicating that the property is not supported is 
displayed. These settings are used only for printing from this system to 
the printer. However, these settings do not affect the printer properties of 
the network printer.

Firmware upgrade (HTTP) 

You can upgrade your printer’s firmware using the HTTP protocol. First, 
you need to download firmware from the website.

Note: Before upgrading the firmware, make sure that TCP/IP 
parameters are entered in the print server.

1 Run your web browser and access Web Image Monitor SP 3300 
Series.

2 Click Maintenance > Firmware Upgrade.

3 Insert the CD or download the upgrade from the internet.

4 Click Browse, and then select the downloaded new firmware.

5 Click Upgrade.

Note: It takes a few minutes to upgrading the firmware. 
After completely upgrade, the printer will be reset.

Default setting (HTTP/SNMP)

You can reset all of your network parameter settings to their default 
status.

Note: All default parameters will be applied after the print server 
restarts.

IP filtering

This security feature (IP Filtering) provides the ability to prevent 
unauthorised network access to the network print server based on IP 
addresses set by a network administrator using Web Image Monitor SP 
3300 Series. 

1 Run your web browser and access Web Image Monitor SP 3300 
Series.

2 Select Network Settings > IP Filtering.

3 Configure an IP filter.

• IP Filtering: You can enable or disable IP filtering.

• IP Address 1 ~ IP Address 10: You can enter filtered IP 
addresses. Users having the IP addresses set here are able to 
access the network print server.

4 Click Apply.

Only system administrators or authorised users can set, via Web Image 
Monitor SP 3300 Series, IP addresses that can access the device. Up to 
10 addresses or ranges of address choices can be made and set. 
Authorised users are able to change the action (Apply/ Undo) and to print 
to the network print server.

Note: Ranges of addresses shouldn't contain “null” or “0.0.0.0” values.

Reset

1 Run your web browser and access Web Image Monitor SP 3300 
Series.

2 Click Network Settings > Reset.

You can reboot the network print server, if your network settings are not 
applied correctly or the network card is disconnected from your network.

Ethernet speed 

You can set the communication speed for Ethernet connections.

1 Run your web browser and access Web Image Monitor SP 3300 
Series. 

2 Click Network Settings > General.

• Speed Rate: Automatic, 10 Mbps (Harf Duplex), 
10 Mbps (Full Duplex), 100 Mbps (Harf Duplex),
100 Mbps (Full Duplex). select a Ethernet speed from the drop-
down list.

3 Click Apply. 
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5 EtherTalk environment
EtherTalk is AppleTalk used in an Ethernet network. This protocol is 
widely used in Macintosh network environments. Microsoft Windows 
system also supports this protocol. Like TCP/IP, EtherTalk also provides 
packet transmission and routing functionality.

The network printer card works on EtherTalk networks, if the host printer 
supports PostScript. The description in this chapter applies to network 
printing from a Macintosh computer. 

EtherTalk printing
Printing in an EtherTalk network is possible with several different 
hardware and software configurations. When you issue a command to 
print a document, the application begins a series of EtherTalk calls 
attempting to establish a connection to the printer. The calls first initiate 
the NBP (Name Binding Protocol) name-lookup process to find the 
currently selected printer and its EtherTalk address. Then the Printer 
Access Protocol (PAP) is used to open a connection with the printer.

Once the connection has been established, the workstation and printer 
interact over a PAP connection. PAP uses lower-level protocols, such as 
ATP and DDP, to provide a data-stream service for sending print data to 
the printer. 

Configuring EtherTalk
You can configure EtherTalk using the following method:

Web Image Monitor SP 3300 Series

1 Run your web browser.

2 Enter the printer's IP address in the URL field and click Go. 

3 Select Network Settings > EtherTalk.

• EtherTalk Protocol: allows you to enable or disable the 
EtherTalk protocol. 

• Printer Name: allows you to set the printer name for EtherTalk 
protocol. The default name is RNP+MAC address. This name is 
automatically displayed on Chooser.

• Printer Type: shows the printer type. 

• Last Error Occurred: shows the last error.

• RTMP (timer value for aging A-Router entity): allows you to 
set the time in seconds after which the routing table entry 
maintained by the RTMP protocol times out.

• PAP (wait time before transmitting a tickle packet): enables 
you to define the time interval in seconds after which the PAP 
protocol should resend a tickle packet to verify the status of the 
PAP connection between the printer and your Macintosh. 

• ZIP (current zone): shows the AppleTalk Zone name. If there is 
no configured zone, *(asterisk) should be displayed.

4 Click Apply.

Configuring the printer

Note: The following instructions are for Mac OS 10.3, but similar for 
other versions.

The following steps must be taken to configure the network printer for 
use on a Macintosh system. If the network printer you want to use is not 
listed in the printer pop-up menu when you try to print a document, you 
should add it to your list of available printers. 

1 Open the Applications folder > Utilities, and Print Setup Utility.

• For MAC OS 10.5, open System Preferences from the 
Applications folder, and click Printer & Fax.

2 Click Printing > Set Up Printers. 

3 If the printer already appears in the printer list, select the In Menu 
check box to add it to your list of available printers. You will see the 
printer in the Printer pop-up menu the next time you print.

4 Click Add on the Printer List.

• For MAC OS 10.5, press the “+” icon then a display window will 
pop up. 

5 For MAC OS 10.3, select the Rendezvous tab. 

• For MAC OS 10.4, click Default Browser and find the Bonjour.

• For MAC OS 10.5, click Default and find the Bonjour.

6 If necessary, choose an AppleTalk zone from the pop-up menu that 
appears directly below it. Any AppleTalk printers in the zone you 
have chosen appear in the Printer List.

7 Select the printer in the Printer List.

8 To use printer-specific features, choose the item appropriate for 
your printer from the Printer Model pop-up menu, then select your 
printer in the Model Name list.

9 Click Add.

The printer appears in the Printer List as the default printer (in 
boldface). It also appears in the Printer pop-up menu when you 
print a document.
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TCP/IP printing
Apple added TCP/IP printing to all versions including and after OS 8.6. 

Note: Ensure that the Macintosh has version 8.6 or later. Earlier 
versions do not support TCP/IP printing as standard.

An IP printer is a network printer that uses TCP/IP protocols (such as 
LPD/LPR, IPP, or Socket or Jet Direct) to make itself accessible to your 
computer. If the IP printer you want to use is not listed when you want to 
print, you can add it to your list of available printers. To add an IP printer, 
you need to know its IP address or DNS name.

1 Open the Applications folder > Utilities, and Print Setup Utility.

• For MAC OS 10.5, open System Preferences from the 
Applications folder, and click Printer & Fax.

2 Click Printing > Set Up Printers. 

3 If the printer already appears on the Printer List, select the In Menu 
check box to add it to your list of available printers. You will see the 
printer in the Printer pop-up menu the next time you print.

4 Click Add on the Printer List.

• For MAC OS 10.5, press the “+” icon then a display window will 
pop up. 

5 For MAC OS 10.3, select the IP Printing tab. 

• For MAC OS 10.4, click IP Printer.

• For MAC OS 10.5, click IP.

6 Select the appropriate printing protocol from the Printer Type pop-
up menu.

7 Enter the IP address or DNS name for the printer in the Printer 
Address field.

8 If your printer requires it, type the queue name for your printer in 
the Queue Name field. 

9 To use printer-specific features, choose the item appropriate for 
your printer from the Printer Model pop-up menu, then select your 
printer in the Model Name list.

10 Click Add.

The printer appears on the Printer List as the default printer (in 
boldface). It also appears in the Printer pop-up menu when you 
print a document. 

Bonjour printer
Usually used in Macintosh networks to search for network devices, 
Bonjour consists of IPv4 Link-Local Addressing, Multicast DNS, and 
DNS Service Discovery. Known as zero configuration networking, 
Bonjour uses industry standard IP protocols to allow devices to 
automatically find each other without the need to enter IP addresses or 
configure DNS servers.

In order to provide a true zero configuration experience, meaning that 
you do not need to configure network parameters, the printer MUST 
have Bonjour enabled by default. It is NOT possible to disable any part 
of Bonjour.

After boot up, check the Bonjour printer name of this printer network card 
in Mac OS X. 

1 Open the Applications folder > Utilities, and Print Setup Utility.

• For MAC OS 10.5, open System Preferences from the 
Applications folder, and click Printer & Fax.

2 Click Printing > Set Up Printers. 

3 If the printer already appears on the Printer List, select the In Menu 
check box to add it to your list of available printers. You will see the 
printer in the Printer pop-up menu the next time you print.

4 Click Add on the Printer List.

• For MAC OS 10.5, press the “+” icon then a display window will 
pop up. 

5 For MAC OS 10.3, select the Rendezvous tab. 

• For MAC OS 10.4, click Default Browser and find the Bonjour.

• For MAC OS 10.5, click Default and find the Bonjour.

Any Bonjour-enabled printers on your local network or subnetwork 
appear on the Printer List.

6 Select your printer from the Printer List.

7 To use printer-specific features, choose the item appropriate for 
your printer from the Printer Model pop-up menu, then select your 
printer in the Model Name list.

8 Click Add.

The printer appears on the Printer List as the default printer (in 
boldface). It also appears in the Printer pop-up menu when you 
print a document. 

Download from Www.Somanuals.com. All Manuals Search And Download.



Administration Tools
6.1

6 Administration Tools
This chapter explains how to configure or use the various administration 
tools found in SP 3300 Series. The following information is provided:

Maintenance using Internet Services

Enabling Internet Services
1 At a client workstation on the network, launch the Internet Browser.

2 In the URL field, enter http:// followed by the IP Address of the SP 
3300 Series. Then select the [Enter] key.

Example: If the IP Address is 192.168.100.100, enter the following 
in the URL field:
           
        http://192.168.100.100

Checking Printer Status
Use these instructions to check the status of SP 3300 Series, the paper 
trays and consumables.

To check the status, perform these steps:

1 Enable SP 3300 Series (see “Enabling Internet Services” on 
page 6.1).

2 At SP 3300 Series Home Page for SP 3300 Series, select the 
Information tab. 

3 Click Print Information in the left frame.

Printing Reports
Use these instructions to print the printer’s reports or to send a test print 
file to SP 3300 Series.

To print reports, perform these steps:

1 Enable SP 3300 Series (see “Enabling Internet Services” on 
page 6.1).

2 At SP 3300 Series Home Page for SP 3300 Series, select the 
Information tab. 

3 Click Print Information menu in the left frame. Then click the 
appropriate Print link to print:

Print Information

• Print Printer Configuration Page

• Print Demo Page

• Print Menu Map

• Print PCL Font List

• Print PS3 Font List

Network Information Page

• Print Network Configuration Page 

Making and Changing Network Admin 
Password
Use these instructions to change the admin user’s password.

To make admin user’s password settings, perform these steps:

1 Enable SP 3300 Series (see “Enabling Internet Services” on 
page 6.1).

2 At SP 3300 Series Home Page for SP 3300 Series, select the 
Maintenance tab. 

3 Click Security menu in the left frame.

4 Select the checkbox to Enable Security for using security.

5 To change the Admin User Password, in the change Admin User 
Name and Password area:

Enter the New Admin Name and Old Admin Name.

Enter the New Admin Password and Old Admin Password.

6 Click the Apply button to implement any changes.

Note: Click the Undo button to cancel any changes made and return to 
the previous values.

Upgrading Firmware
Firmware upgrades may supplied on a CD or as a download from the 
internet. Use these instructions to install firmware upgrades in SP 3300 
Series.

To upgrade the firmware, perform these steps:

1 Enable SP 3300 Series (see “Enabling Internet Services” on 
page 6.1).

2 At SP 3300 Series Home Page for SP 3300 Series, select the 
Maintenance tab. 

3 Click Firmware Upgrade in the left frame.

4 Insert the CD or download the upgrade from the internet.

5 Enter the file name and location or Browse to the location and 
select the file.

6 Click the Upgrade button.
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Specifications

OpenSSL Statements

OpenSSL License
Copyright © 1998-2000 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without 
modification, are permitted provided that the following conditions are 
met:

1 Redistributions of source code must retain the above copyright 
notice, this list of conditions and the following disclaimer.

2 Redistributions in binary form must reproduce the above copyright 
notice, this list of conditions and the following disclaimer in the 
documentation and/or other materials provided with the 
distribution.

3 All advertising materials mentioning features or use of this software 
must display the following acknowledgment:

Items Specifications

Supported 
networks

• Windows: 2000, XP, Vista, Windows Server 
2003

• Macintosh: MAC OS 8.6 ~ 9.2, 10.1 ~ 10.5

Protocol TCP/IP, EtherTalk, SNMP, HTTP 1.1, Bonjour

Configurationu
tilities

SetIP, Web Image Monitor SP 3300 Series

Hardware 
requirements

• PC:
-  80486 CPU or higher
-  Minimum of 16 MB of RAM
-  2 MB of free disk space

• Macintosh: 
-  PowerPC 68020 or higher 
-  Minimum of 8 MB of RAM
-  2 MB of free disk space

Wireless 
interface

IEEE 802.11a/b/g standard

4 “This product includes software developed by the OpenSSL Project 
for use in the OpenSSL Toolkit. (http://www.openssl.org/)”

5 The names “OpenSSL Toolkit” and “OpenSSL Project” must not be 
used to endorse or promote products derived from this software 
without prior written permission.

6 For written permission, please contact openssl-core@openssl.org.

7 Products derived from this software may not be called “OpenSSL” 
nor may “OpenSSL” appear in their names without prior written 
permission of the OpenSSL Project.

8 Redistributions of any form whatsoever must retain the following 
acknowledgment:

“This product includes software developed by the OpenSSL Project for 
use in the OpenSSL Toolkit (http://www.openssl.org/)”

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT “AS IS” 
AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT 
OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED 
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, 
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE.

This product includes cryptographic software written by Eric Young 
(eay@cryptsoft.com). 
This product includes software written by Tim Hudson 
(tjh@cryptsoft.com).
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